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1. Introduction
This chapter provides information you need to know before using the machine.
• Key benefits 4
• Features by model 6
• Useful to know 9
• About this user’s guide 10
• Safety information 11
• Machine overview 17
• Control panel overview 20
• Turning on the machine 22
• Installing the driver locally 23
• Reinstalling the driver 25



Key benefits

Environmentally friendly

• To save toner and paper, this machine supports the Eco feature (see "Easy 
Eco Driver" on page 149).

• To save paper, you can print multiple pages on a single sheet of paper (see 
"Using advanced print features" on page 134).

• To save paper, you can print on both sides of the paper (manual double-
sided printing) (see "Using advanced print features" on page 134).

• To save electricity, this machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• We recommend using recycled paper for saving energy.

Fast high resolution printing

• You can print in a full range of colors using cyan, magenta, yellow, and black.

• You can print with a resolution of up to 2,400 x 600 dpi effective output (600 
x 600 x 2 bit).

• Fast, on-demand printing.

Convenience

• Simply touch your cell phone on the NFC tag on your printer and get the 
print job done (see "Using the NFC feature" on page 125). 

• Easy Capture Manager allows you to easily edit and print whatever you 
captured using the Print Screen key on the keyboard (see "Easy Capture 
Manager" on page 147).

• Samsung Easy Printer Manager and Samsung Printer Status are a program 
that monitors and informs you of the machine’s status and allows you to 
customize the machine’s settings (see "Using Samsung Easy Printer 
Manager" on page 156 or "Using Samsung Printer Status" on page 158).

• Smart Update allows you to check for the latest software and install the 
latest version during the printer driver installation process. This is available 
only for Windows OS users.

• If you have Internet access, you can get help, support application, machine 
drivers, manuals, and order information from the Samsung website, 
www.samsung.com > find your product > Support or Downloads.



Key benefits

Wide range of functionality and application support

• Supports various paper sizes (see "Print media specifications" on page 70).

• Print watermark: You can customize your documents with words, such as 
“CONFIDENTIAL” (see "Using advanced print features" on page 134).

• Print posters: The text and pictures of each page of your document are 
magnified and printed across the multiple sheets of paper and can then be 
taped together to form a poster (see "Using advanced print features" on 
page 134).

• You can print in various operating systems (see "System requirements" on 
page 73).

• Your machine is equipped with a USB interface and/or a network interface.

Supports various wireless network setting method 

• Using the WPS (Wi-Fi Protected Setup™) button

- You can easily connect to a wireless network using the WPS button on 
the machine and the access point (a wireless router).

• Using the USB cable or a network cable

- You can connect and set various wireless network settings using a USB 
cable or a network cable.

• Using the Wi-Fi Direct

- You can conveniently print from your mobile device using the Wi-Fi or 
Wi-Fi Direct feature.

 

See "Introducing wireless set up methods" on page 107.

 



Features by model

Some features and optional goods may not be available depending on model or country.

Operating System
 

 

(●: Supported) 

Operating System C43x series C43xW series

Windows ● ●

Mac ● ●

Linux ● ●



Features by model

Software
 

 You can install the printer driver and software when you insert the software CD into your CD-ROM drive.

For Windows, select the printer driver and software in the Select Software to Install window.

 

 

 

(●: Supported, Blank: Not supported) 

Software C43x series C43xW series

SPL printer driver ● ●

XPS printer drivera

a. Download the software from the Samsung website and install it: (http://www.samsung.com > find your product > Support or Downloads). Before installing, check whether your 
computer’s OS support the software.

● ●

Samsung Easy Color Managera ● ●

Samsung Easy Printer Manager ● ●

Samsung Printer Center ● ●

Samsung Printer Status ● ●

Eco Driver Packb

b. To use the Easy Eco Driver features, the Eco Driver Pack must be installed.

● ●

Samsung Stylish Driver Packc

c. The printer driver includes a user interface that is optimized for touchscreens. To use this UI, click Samsung Printer Center > Device Options and then select Stylish User Interface 
(see "Using Samsung Printer Center" on page 150).

● ●

SyncThru™ Web Service ●

http://www.samsung.com
http://www.samsung.com


Features by model

Variety feature
 

 

(●: Supported, Blank: Not supported) 

Features C43x series C43xW series

Hi-Speed USB 2.0 ● ●

Network Interface Ethernet 10/100 Base TX wired LAN ●

Network Interface 802.11b/g/n wireless LANa

a. Depending on your country, wireless LAN card may not be available. For some countries, only 802.11 b/g can be applied. Contact your local Samsung dealer or the retailer where you 
bought your machine.

●

IPv6 ●

NFC (Near Field Communication) printing ●

Mopria™ ●

AirPrint ●

Wi-Fi Protected Setup™ (WPS) ●

Eco printing (Easy Eco Driver)b

b. Setting the ECO settings is available from the windows driver.

● ●

Manual duplex (2-sided) printingc

c. Available for Windows OS users only.

● ●



Useful to know
Where can I download the machine’s driver?

• Visit www.samsung.com/printer to download the latest 
machine’s driver, and install it on your system.

Where can I purchase accessories or supplies?

• Inquire at a Samsung distributor or your retailer.

• Visit www.samsung.com/supplies. Select your country/region 
to view product service information.

The status LED flashes or remains constantly on.

• Turn the product off and on again.

• Check the meanings of LED indications in this manual and 
troubleshoot accordingly (see "Understanding the status LED" 
on page 63).

A paper jam has occurred.

• Open and close the cover (see "Front view" on page 18).

• Check the instructions on removing jammed paper in this 
manual and troubleshoot accordingly (see "Clearing paper 
jams" on page 60).

Printouts are blurry.

• The toner level might be low or uneven. Shake the toner 
cartridge.

• Try a different print quality setting.

• Replace the toner cartridge.

The machine does not print.

• Open the print queue list and remove the document from the 
list (see "Canceling a print job" on page 36).

• Remove the driver and install it again (see "Installing the driver 
locally" on page 23).

• Select your machine as your default machine in your Windows.

http://www.samsung.com/printer
http://www.samsung.com/printer


About this user’s guide

This user's guide provides information for your basic understanding of the 

machine as well as detailed steps to explain machine usage.

•  Do not discard this manual, and keep it for future reference.

• Read the safety information before using the machine.

• If you have a problem using the machine, refer to the troubleshooting 
chapter.

• Terms used in this user’s guide are explained in the glossary chapter.

• All illustrations in this user’s guide may differ from your machine depending 
on its options or model you purchased.

• The screenshots in this user's guide may differ from your machine 
depending on the machine’s firmware/driver version.

• The procedures in this user’s guide are mainly based on Windows 7.

1 

Conventions

Some terms in this guide are used interchangeably, as below:

• Document is synonymous with original.

• Paper is synonymous with media, or print media.

• Machine refers to printer or MFP.

2 

General icons

Icon Text Description

Caution
Gives users information to protect the machine from 
possible mechanical damage or malfunction.

Warning
Used to alert users to the possibility of personal injury.

Note
Provides additional information or detailed 
specification of the machine function and feature.
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Safety information

These warnings and precautions are included to prevent injury to you and 

others, and to prevent any potential damage to your machine. Be sure to read 

and understand all of these instructions before using the machine. After reading 

this section, keep it in a safe place for future reference.

3 

Important safety symbols

Explanation of all icons and signs used in this chapter

4 

Operating environment

 Warning

Warning
Hazards or unsafe practices that may result in severe 
personal injury or death.

Caution
Hazards or unsafe practices that may result in minor 
personal injury or property damage.

Do not attempt.

Do not use if the power cord is damaged or if the electrical outlet is 
not grounded.

This could result in electric shock or fire. 

Do not place anything on top of the machine (water, small metal or 
heavy objects, candles, lit cigarettes, etc.).

This could result in electric shock or fire. 

• If the machine gets overheated, it releases smoke, makes strange 
noises, or generates an odd odor, immediately turn off the power 
switch and unplug the machine.

• The user should be able to access the power outlet in case of 
emergencies that might require the user to pull the plug out.

This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power cord. 

Stepping on or allowing the power cord to be crushed by a heavy 
object could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not handle the 
plug with wet hands. 

This could result in electric shock or fire. 
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Safety information
 Caution
5 

Operating method

 Caution
During an electrical storm or for a period of non-operation, 
remove the power plug from the electrical outlet. 

This could result in electric shock or fire. 

Be careful, the paper output area is hot. 

Burns could occur. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections and 
request assistance from qualified service personnel.

Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these instructions 
have been followed, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.

Otherwise, this could result in electric shock or fire.

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 

Call an electrician to change the electrical outlet, or this could 
result in electric shock.

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.

This could result in electric shock or fire and/or injury to your pet. 

Do not forcefully pull the paper out during printing. 

It can cause damage to the machine.

Be careful not to put your hand between the machine and paper 
tray.

You may get injured.

Be careful when replacing paper or removing jammed paper. 

New paper has sharp edges and can cause painful cuts.

When printing large quantities, the bottom part of the paper 
output area may get hot. Do not allow children to touch. 

Burns can occur.

When removing jammed paper, do not use tweezers or sharp metal 
objects. 

It can damage the machine.

Do not allow too many papers to stack up in the paper output tray.

It can damage the machine. 
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Safety information
6 

Installation / Moving

 Warning

Do not block or push objects into the ventilation opening.

This could result in elevated component temperatures which can 
cause damage or fire.

Use of controls or adjustments or performance of procedures other 
than those specified herein may result in hazardous radiation 
exposure.

This machine's power reception device is the power cord. 

To switch off the power supply, remove the power cord from the 
electrical outlet. 

Do not place the machine in an area with dust, humidity, or water 
leaks. 

This could result in electric shock or fire. 

Place the machine in the environment where it meets the 
operating temperature and humidity specification.

Do not use the machine when it is below freezing temperature or 
has recently been moved from a location below freezing 
temperature. Doing so may damage the machine. Only operate the 
machine when the internal temperature of the machine is within 
the operating temperature and humidity specifications.

Otherwise, quality problems can occur and cause damage to the 
machine. 

See "General specifications" on page 68.
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Safety information
 Caution

Before moving the machine, turn the power off and disconnect all 
cords. The information below are only suggestions based on the 
units weight.

If you have a medical condition that prevents you from lifting, do 
not lift the machine. Ask for help, and always use the appropriate 
amount of people to lift the device safety.

Then lift the machine:

•  If the machine weighs under 20 kg (44.09 lbs), lift with 1 person.

•  If the machine weighs 20 kg (44.09 lbs) - 40kg (88.18 lbs), lift 
with 2 people.

•  If the machine weighs more than 40 kg (88.18 lbs), lift with 4 or 
more people.

The machine could fall, causing injury or machine damage.

Choose a flat surface with enough space for ventilation to place 
the machine. Also consider the space required to open the cover 
and trays. 

The place should be well-ventilated and be far from direct light, 
heat, and humidity. 

When using the machine for a long period of time or printing a 
large number of pages in a non-ventilated space, it could pollute 
the air and be harmful to your health. Place the machine  in a well-
ventilated space or open a window to circulate the air periodically.

Do not place the machine on an unstable surface.

The machine could fall, causing injury or machine damage.

Use only No.26 AWGa or larger, telephone line cord, if necessary.

Otherwise, it can cause damage to the machine.

Make sure you plug the power cord into a grounded electrical 
outlet.

Otherwise, this could result in electric shock or fire.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters (6 
feet) with a 110V machine, then the gauge should be 16 AWG or 
larger.

Otherwise, it can cause damage to the machine, and could result 
in electric shock or fire.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.

If the machine is not well-ventilated, this could result in fire.

Do not overload wall outlets and extension cords.

This can diminish performance, and could result in electric shock 
or fire.

The machine should be connected to

the power level which is specified on the label.

If you are unsure and want to check the power level you are using, 
contact the electrical utility company.

a. AWG: American Wire Gauge
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Safety information

7 

Maintenance / Checking

 Caution

8 

Supply usage

 Caution

Unplug this product from the wall outlet before cleaning the 
inside of the machine. Do not clean the machine with benzene, 
paint thinner or alcohol; do not spray water directly into the 
machine. 

This could result in electric shock or fire. 

When you are working inside the machine replacing 
consumables or cleaning the inside, do not operate the machine.

You could get injured.

Keep cleaning consumables away from children. 

Children could get hurt.

Do not disassemble, repair or rebuild the machine by yourself. 

It can damage the machine. Call a certified technician when the 
machine needs repairing.

To clean and operate the machine, strictly follow the user's guide 
provided with the machine.

Otherwise, you could damage the machine.

Keep the power cable and the contact surface of the plug clean 
from dust or water.

Otherwise, this could result in electric shock or fire. 

• Do not remove any covers or guards that are fastened with 
screws. 

• Fuser units should only be repaired by a certified service 
technician. Repair by non-certified technicians could result in 
fire or electric shock.

• The machine should only be repaired by a Samsung service 
technician.

Do not disassemble the toner cartridge.

Toner dust can be dangerous if inhaled or ingested.

Do not burn any of the consumables such as toner cartridge or 
fuser unit.

This could cause an explosion or uncontrollable fire.
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Safety information
When storing consumables such as toner cartridges, keep them 
away from children.

Toner dust can be dangerous if inhaled or ingested.

Using recycled consumables, such as toner, can cause damage to 
the machine.

In case of damage due to the use of recycled consumables, a 
service fee will be charged.

For consumables that contain toner dust (toner cartridge, waste 
toner bottle, imaging unit, etc.) follow the instructions below.

• When disposing of the consumables, follow the instructions 
for disposal. Refer to the reseller for disposal instructions.

• Do not wash the consumables.

• For a waste toner bottle, do not reuse it after emptying the 
bottle.

If you do not follow the instructions above, it may cause machine 
malfunction and environmental pollution.  The warranty does 
not cover damages caused by a user's carelessness.

When toner gets on your clothing, do not use hot water to wash 
it.

Hot water sets toner into fabric. Use cold water.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.

Toner dust can be dangerous if inhaled or ingested.
161. Introduction



Machine overview

9 

Components

The actual component may differ from the illustration below. Some components may change depending on the configuration.

Machine Quick installation guide

Power cord Software CDa

a. The software CD contains the print drivers, user’s guide, and software applications.

Misc. accessoriesb

b. Miscellaneous accessories included with your machine may vary by country of purchase and specific model.
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Machine overview

10 

Front view

 

• This illustration may differ from your machine depending on its model.

• Some features and optional goods may not be available depending on 
model or country (see "Features by model" on page 6).

 

9

10

11

2 3

6
7

5

4

8

1

1 Output tray 7 Front cover release button

2 Output support 8 NFC taga

a. C43xW series only.

3 Top cover 9 Toner cartridges

4 Control Panel 10 Waster toner container

5 Tray 11 Imaging unit

6 Front cover
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Machine overview

11 

Rear view

 

• This illustration may differ from your machine depending on its model.

• Some features and optional goods may not be available depending on model or country (see "Features by model" on page 6).

 

1 Rear cover

2 Power receptacle

3 USB port

4 Network port

1

4

3

2
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Control panel overview

 

This control panel may differ from your machine depending on its model. 
There are various types of control panels.

 

1 Toner 
LED

Shows the status of the toner (see "Status LED" on page 64).

2
Eco

Turn into eco mode to reduce toner consumption and paper 
usage when pc-printing only (see "Eco printing" on page 38). 

1

2

3

4

6

5

3

(WPS)a

Configures the wireless network connection easily without a 
computer (see "Wireless network setup" on page 107).

• Manual print
- Press this button each time you load a sheet of paper in the 

tray if you have selected Manual Feeder for Source in your 
printer driver.

 

(Print 

screen)b

• Prints the screen 
- Press this button and the blue LED will start blinking. If you 

want to print only the active screen, release the button 
when the blue LED stops blinking. If you want to print the 
whole screen, release the button while it’s blinking.

- Manual print
▪ Press this button each time you load a sheet of paper in 

the tray if you have selected Manual Feeder for Source 
in your printer driver.

 

• Print Screen  can only be used in the Windows and 
Mac operating systems.

• You can only use this function with USB-connected 
machine.

• When printing the active window/whole monitor 
screen using the print screen button, the machine may 
use more toner depending on what is being printed.

• You can only use this function if the machine’s Easy 
Printer Manager program is installed if you are a Mac 
OS user, you need to enable Screen Print Settings 
from the Easy Printer Manager to use the Print Screen 
feature.
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Control panel overview
4

(Cancel)

You can stop an operation at any time. You also can do the 
following functions.

• Configuration / Network Configuration Reporta

- Press and hold this button for about 2 seconds until the 
blue LED blinks slowly, and release.

• Error Information / Usage Counter
- Press and hold this button for about 4 seconds until the 

blue LED blinks quickly, and release.

• Supplies Information
- Press and hold this button for about 6 seconds until the 

blue LED on, and release.

5

(Power/
Wake Up)

You can turn the power off or wake the machine up from the sleep 
mode with this button.

6

 (Status 
LED)

Shows the status of your machine (see "Status LED" on page 64).

a. C43xW series only.
b. C43x series only.
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Turning on the machine

 

Keep in mind that you should use the power cord supplied with the machine. Otherwise, it can cause damage or fire to the machine.

 

1 Connect the machine to the electricity supply first.

2 press (Power/Wake Up) button on the control panel.

 

 If you want to turn the power off, press and hold  (Power/Wake Up) button for about 3 seconds.

 

1

2
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Installing the driver locally

A locally connected machine is a machine directly attached to your computer 

using a USB cable. If your machine is attached to a network, skip the following 

steps below and go on to installing a network connected machine’s driver (see 

"Installing driver over the network" on page 100).

 

• If you are a Mac or Linux operating systems user, refer to the "Installation 
for Mac" on page 91 or "Installation for Linux" on page 93. 

• The installation window in this User’s Guide may differ depending on the 
machine and interface in use.

• Only use a USB cable no longer than 3 meters (118 inches).

 

12 

Windows

1 Make sure that the machine is connected to your computer and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

 X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3 Review and accept the installation agreements in the installation 
window. Then, click Next.

4 Select USB on the Printer Connection Type screen. Then, click Next.

5 Follow the instructions in the installation window.

 

You can select the software applications in the Select Software to Install 
window.
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Installing the driver locally

From the Windows 8 Start Screen

 

• The V4 driver is automatically downloaded from the Windows Update if 
your computer is connected to the Internet. If not, you can manually 
download the V4 driver from Samsung website, www.samsung.com > 
find your product > Support or downloads. 

• You can download Samsung Printer Experience app from the Windows 
Store. You need have a Microsoft account to use the Windows Store.

1 From Charms, select Search. 

2 Click Store.

3 Search and click Samsung Printer Experience.

4 Click Install.

• If you install the driver using the supplied software CD, V4 driver is not 
installed. If you want to use the V4 driver in the Desktop screen, you can 
download from the Samsung website, www.samsung.com >find your 
product > Support or downloads.

• If you want to install Samsung’s printer management tools, you need to 
install them using the supplied software CD.

 

1 Make sure that your computer is connected to the Internet and powered 
on.

2 Make sure that the machine is powered on.

3 Connect the computer and the machine with a USB cable.

The driver is automatically installed from the Windows Update. 
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Reinstalling the driver

If the printer driver does not work properly, follow the steps below to reinstall 

the driver.

13 

Windows

1 Make sure that the machine is connected to your computer and 
powered on.

2 From the Start menu, select Programs or All Programs > Samsung 
Printers > Uninstall Samsung Printer Software.

• For Windows 8,

1 From Charms, select Search > Apps. 

2 Search and click Control Panel.

3 Click Programs and Features.

4 Right-click the driver you want to uninstall and select Uninstall. 

3 Follow the instructions in the installation window.

4 Insert the software CD into your CD-ROM drive and install the driver 
again (see "Installing the driver locally" on page 23).

From the Windows 8 Start Screen

1 Make sure that the machine is connected to your computer and 
powered on.

2 Click on the Uninstall Samsung Printer Software in the Start screen.

3 Follow the instructions in the window.

 

• If you cannot find a Samsung Printer Software tile, unintstall from the 
desktop screen mode. 

• If you want to uninstall Samsung’s printer management tools, from the 
Start screen, right-click the app > Uninstall > right-click the program 
you want to delete > Uninstall and follow the instruction in the window. 
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2. Learning the Basic Usage
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would 
like to set or change values. This chapter provides information about the overall menu structure and the basic setup 
options.
• Media and tray 27
• Basic printing 35



Media and tray

This chapter provides information on how to load print media into your 

machine.

 

• Using print media that does not meet these specifications may cause 
problems or require repairs. Such repairs are not covered by Samsung’s 
warranty or service agreements.

• Make sure not to use the inkjet photo paper with this machine. It could 
cause damage to the machine. 

• Using inflammable print media can cause a fire.

• Use designated print media (see "Print media specifications" on page 
70).

 

 

The use of inflammable media or foreign materials left in the printer may 

lead to overheating of the unit and, in rare cases may cause a fire.

 

1 

Tray overview

To change the size, you need to adjust the paper guide.

 

If you do not adjust the guide, it may cause paper registration, image skew, 
or jamming of the paper.

 

1 Paper cover
2 Guide lock
3 Paper length guide
4 Paper width guide

21

4

3

272. Learning the Basic Usage



Media and tray

2 

Loading paper in the tray

1 Pull out the paper tray (see "Tray overview" on page 27).

2 Open the paper cover.

3 Squeeze and the paper width guide and paper length lever to locate 
them in the correct paper size slot marked at the bottom of the tray to 
adjust to the size.

4 Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

2
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Media and tray

5 Place the paper with the side you want to print facing up.

For paper smaller than Letter-sized, press and unlatch the guide lock in 
the tray, push the tray in manually. Then adjust the paper length guide 
and paper width guide.

For paper longer than A4-sized(like ‘Legal’), press and unlatch the guide 
lock in the tray, pull the tray out manually. Then adjust the paper length 
guide and paper width guide.

 

• Do not push the paper width guide too far causing the media to buckle.

• If you do not adjust the paper width guide, it may cause paper jams.

• Do not use a paper with a leading-edge curl, it may cause a paper jam or 
the paper can be wrinkled.

 

2

1
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Media and tray

6 Squeeze the paper width guide and slide it to the edge of the paper stack 

without causing it to buckle.

7 Close the paper cover.

8 Insert the paper tray.

9 When you print a document, set the paper type and size for the tray (see 
"Setting the paper size and type" on page 34).
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Media and tray

The tray is preset to Letter or A4 size, depending on your country. To change the 

size to A4 or Letter, you must adjust the lever and paper width guide properly.

1 Pull the tray out of the machine. Open the paper cover and remove 
paper from the tray if necessary.

2 If you want to change the size to Letter, hold the lever at the back of the 
tray, and rotate the lever clockwise. You can see the lever when you 
move the paper length guide to the legal-sized paper(LGL).

3 Squeeze the paper width guide and slide it to the edge of the lever.

 

If you want to change the size to A4, first move the paper width guide to left 
and rotate the lever counterclockwise. If you force the lever, it could 
damage the tray.

 

LTR
A4

LTR
A4
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Media and tray

3 

Printing on special media

The paper setting in the machine and driver should match to print without a 

paper mismatch error. 

• You change the paper setting set in the machine from Samsung Easy Printer 

Manager program or SyncThru™ Web Service.

- If your machine is connected to the local, you can set the machine’s setting from 

Samsung Easy Printer Manager > Advanced Setting > Device Settings (see 
"Using Samsung Easy Printer Manager" on page 156).

- If your machine is connected to the network, you can set the machine’s 
setting from SyncThru™ Web Service > Settings tab > Machine 
Settings (see "Using SyncThru™ Web Service" on page 153).

 

When using special media, we recommend you feed one sheet at a time (see 
"Print media specifications" on page 70).

 

To see paper weights for each sheet, refer to "Print media specifications" on 

page 70.

(●: Supported) 

Types Traya

Plain ●

Thick ●

Thin ●

Bond ●

Color paper ●

CardStock ●

Labels ●

Preprinted ●

Cotton ●

Recycled ●

Archive ●

Glossy Photo ●

Matte Photo ●

a. The paper types available manual feeding in tray.

Types Traya
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Labels

To avoid damaging the machine, use only labels designed for use in laser 

printers.

• When selecting labels, consider the following factors:

- Adhesives: Should be stable at your machine’s fusing temperature. 
Check your machine’s specifications to view the fusing temperature 
(about 170°C (338°F)).

- Arrangement: Only use labels with no exposed backing between them. 
Labels can peel off sheets that have spaces between the labels, causing 
serious jams.

- Curl: Must lie flat with no more than 5 mm of curl in any direction.

- Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can cause 
paper jams. Exposed adhesive can also cause damage to machine 
components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the machine.

• Do not use labels that are separating from the backing sheet or are wrinkled, 
bubbled, or otherwise damaged.

Card stock/ Custom-sized paper

• In the software application, set margins at least 6.4 mm (0.25 inches) away 
from the edges of the material.
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Preprinted paper

When loading preprinted paper, the printed side should be facing up with an 

uncurled edge at the front. If you experience problems with paper feeding, turn 

the paper around. Note that print quality is not guaranteed.

• Must be printed with heat-resistant ink that will not melt, vaporize, or 
release hazardous emissions when subjected to the machine’s fusing 
temperature for 0.1 second (about 170°C (338°F)).

• Preprinted paper ink must be non-flammable and should not adversely 
affect machine rollers.

• Before you load preprinted paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off preprinted paper, reducing 
print quality.

4 

Setting the paper size and type

After loading paper in the paper tray, set the paper size and type using the 

display screen. For computer printing, select the paper size and type in the 

application program you use on your computer (see "Opening Printing 

Preferences" on page 36).

 

The paper setting in the machine and driver should match to print without 
a paper mismatch error. 

• You change the paper setting set in the machine from Samsung Easy 
Printer Manager program or SyncThru™ Web Service.

- If your machine is connected to the local, you can set the machine’s 
setting from Samsung Easy Printer Manager > Advanced Setting 

> Device Settings (see "Using Samsung Easy Printer Manager" on 
page 156).

- If your machine is connected to the network, you can set the 
machine’s setting from SyncThru™ Web Service > Settings tab > 
Machine Settings (see "Using SyncThru™ Web Service" on page 153).
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For special printing features, refer to the Advanced Guide (see "Using 
advanced print features" on page 134).

 

5 

Printing

 

If you are a Mac or Linux user, refer to the "Mac printing" on page 141 or 
"Linux printing" on page 143.

 

The following Printing Preferences window is for Notepad in Windows 7.

1 Open the document you want to print.

2 Select Print from the File menu.

3 Select your machine from the Select Printer list.

4 The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the advanced printing features, click Properties or 
Preferences from the Print window (see "Opening Printing Preferences" on 
page 36).

 

5 To start the print job, click OK or Print in the Print window.
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Canceling a print job

If the print job is waiting in the print queue or print spooler, cancel the job as 

follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel) on the control 

panel.

7 

Opening Printing Preferences

 

• The Printing Preferences window that appears in this user’s guide may 
differ depending on the machine in use. However, the composition of 
the Printing Preferences window is similar.

• When you select an option in Printing Preferences, you may see a 
warning mark  or  . An  mark means you can select that certain 

option but it is not recommended, and an  mark means you cannot 
select that option due to the machine’s setting or environment.

 

1 Open the document you want to print.

2 Select Print from the file menu.

3 Select your machine from the Select Printer. 

4 Click Properties or Preferences. 
362. Learning the Basic Usage



Basic printing

 

• You can apply Eco features to save paper and toner before printing (see 
"Easy Eco Driver" on page 149).

• You can check the machine's current status using the Printer Status 
button (see "Using Samsung Printer Status" on page 158).

• The printer driver includes a user interface that is optimized for 
touchscreens. To use this UI, click Samsung Printer Center > Device 
Options and then select Stylish User Interface (see "Using Samsung 
Printer Center" on page 150).

 

Using a favorite setting

The Favorites option, which is visible on each preferences tab except for the 

Samsung tab, allows you to save the current preferences for future use.

To save a Favorites item, follow these steps:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box.

3 Click Save. 

4 Enter name and description, and then select the desired icon.

5 Click OK. When you save Favorites, all current driver settings are saved.

 

To use a saved setting, select it in the Favorites tab. The machine is now set 
to print according to the settings you have selected.

To delete saved settings, select it in the Favorites tab and click Delete. 
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Using help

Click the option you want to know on the Printing Preferences window and 

press F1 on your keyboard.

9 

Eco printing

The Eco function cuts toner consumption and paper usage. The Eco function 

allows you to save print resources and lead you to eco-friendly printing.

If you press the Eco button from the control panel, eco mode is enabled. The 

default setting of Eco mode is Multiple Pages per Side (2) and Toner Save. 

Some features may not be available depending on the model.

 

• You change the machine’s setting set in the machine from Samsung 
Easy Printer Manager or SyncThru™ Web Service.

- If your machine is connected to the local, you can set the machine’s 
setting from

Samsung Easy Printer Manager > Advanced Setting > Device 
Settings (see "Using Samsung Easy Printer Manager" on page 156).

- If your machine is connected to the network, you can set the

machine’s setting from SyncThru™ Web Service > Settings tab > 
Machine Settings (see "Using SyncThru™ Web Service" on page 153).

 

 

Depending on the printer driver you use, Skip blank pages may not work 
properly. If Skip blank pages feature does not work properly, set the feature 
from the Easy Eco Driver (see "Easy Eco Driver" on page 149).

 

Setting Eco mode on the control panel

If you press the Eco button from the control panel, eco mode is enabled. The 

default setting of Eco mode is Multiple Pages per Side (2) and Toner Save.

 

If you set the eco mode on with a password from the SyncThru™ Web 
Service (Settings tab > Machine Settings > System > Eco Settings) or 

Samsung Easy Printer Manager (Device Settings > Eco), the On force 
message appears. You have to enter the password to change the eco mode 
status.

 

Setting eco mode on the driver

Open the Eco tab to set Eco mode. When you see the eco image ( ), that 

means the eco mode is currently enabled.

Another way for Eco printing is to use the Easy Eco Driver application. See "Easy 

Eco Driver" on page 149.
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Eco options

• Printer Default: Follows the settings from the machine's control panel.

• None: Disables Eco mode.

• Eco Printing: Enables eco mode. Activate the various Eco items you want to 
use.

• Password: If the administrator fixed to enable the Eco mode, you have to 
enter the password to change the status.

Result simulator

Result Simulator shows the estimated results of reduced emission of carbon 

dioxide, used electricity, and the amount of saved paper in accordance with the 

settings you selected.

• The results are calculated on the basis that the total number of printed 
paper is one hundred without a blank page when the Eco mode is disabled.

• Refers to the calculation coefficient about CO2, energy, and paper from IEA, 
the index of Ministry of Internal Affairs and Communication of Japan and 
www.remanufacturing.org.uk. Each model has a different index. 

• The power consumption in printing mode refers to the average printing 
power consumption of this machine. 

• The actual amount displayed is only an estimate as the actual amount may 
differ depending on the operating system used, computing performance, 
application software, connection method, media type [thickness], media 
size, job complexity, etc.
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This chapter provides information about purchasing supplies, accessories and maintenance parts available for your 
machine.
• Ordering supplies and accessories 41
• Available supplies 42
• Available maintenance parts 44
• Storing the toner cartridge 45
• Redistributing toner 47
• Replacing the toner cartridge 49
• Replacing the waste toner container 51
• Replacing the imaging unit 53
• Cleaning the machine 55
• Tips for moving & storing your machine 57



Ordering supplies and accessories

 

Available accessories may differ from country to country. Contact your sales representatives to obtain the list of available supplies, and maintenance parts.

 

To order Samsung-authorized supplies, accessories, and maintenance parts, contact your local Samsung dealer or the retailer where you purchased your machine. 

You can also visit www.samsung.com/supplies, and then select your country/region to obtain the contact information for service.
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Available supplies

When supplies reach the end of their life spans, you can order the following types of supplies for your machine:

 

Depending on the options, percentage of image area, and job mode used, the toner cartridge’s lifespan may differ.

 

 

When purchasing new toner cartridges or other supplies, these must be purchased in the same country as the machine you are using. Otherwise, new toner 
cartridges or other supplies will be incompatible with your machine due to different configurations of toner cartridges and other supplies according to the specific 
country conditions.

 

Type Average yielda

a. Declared yield value in accordance with ISO/IEC 19798. The number of pages may be affected by operating environment, printing interval, graphics, media type and media size.

Part name

Toner cartridge • Average continuous black cartridge yield: Approx. 1,500 standard pages (Black)

• Average continuous color cartridge yield: Approx. 1,000 standard pages (Yellow/Magenta/Cyan)

• K404 (CLT-K404S): Black

• K403 (CLT-K403S): Blackb

• C404 (CLT-C404S): Cyan

• C403 (CLT-C403S): Cyanb

• M404 (CLT-M404S): Magenta

• M403 (CLT-M403S): Magentab

• Y404 (CLT-Y404S): Yellow

• Y403 (CLT-Y403S): Yellowb

b. This is available only for SL-C435 and SL-C436.

Imaging unit Approx. 16,000 imagesc

c. Image counts based on one color on each page. If you print documents in full color (Cyan, Magenta, Yellow, Black), the life of this item will be reduced by 25%.

CLT-R406

Waste toner container Approx. 7,000 imagesc CLT-W406
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• The toner cartridge included in the printer/all-in-one product you 
purchased is not available for sale and is not guaranteed to be 
compatible with any other printer.

• Samsung does not recommend using non-genuine Samsung toner 
cartridge such as refilled or remanufactured toner. Samsung cannot 
guarantee non-genuine Samsung toner cartridge's quality. Service or 
repair required as a result of using non-genuine Samsung toner 
cartridges will not be covered under the machine’s warranty.
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Available maintenance parts

You need to replace the maintenance parts at specific intervals to keep the machine in the best condition and avoid print quality and paper feeding problems 

resulting from the worn-out parts. Maintenance parts are mostly rollers, belts and pads. However, the replacement period and parts may differ depending on the 

model. Replacing maintenance parts can be performed only by an authorized service provider, dealer, or the retailer where you bought the machine. To purchase 

maintenance parts, contact the retailer where you bought the machine. The replacement period for the maintenance parts is informed by the "Samsung Printer 

Status" program. Or on the UI (User Interface) if your machine supports a display screen. The replacement period varies based on the operating system used, 

computing performance, application software, connecting method, paper type, paper size, and job complexity.
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Storing the toner cartridge

Toner cartridges contain components that are sensitive to light, temperature and humidity. Samsung suggests users follow these recommendations to ensure 

optimal performance, highest quality, and longest life from your new Samsung toner cartridge.

Store this cartridge in the same environment in which the printer will be used. This should be in controlled temperature and humidity conditions. The toner cartridge 

should remain in its original and unopened package until installation – if original packaging is not available, cover the top opening of the cartridge with paper and 

store in a dark cabinet.

Opening the cartridge package prior to use dramatically shortens its useful shelf and operating life. Do not store on the floor. If the toner cartridge is removed from 

the printer, follow the instructions below to store the toner cartridge properly.

• Store the cartridge inside the protective bag from the original package. 

• Store lying flat (not standing on end) with the same side facing up as if it were installed in the machine.

• Do not store consumables in any of the following conditions:

- Temperature greater than 40°C (104°F).

- Humidity range less than 20% and greater than 80%.

- An environment with extreme changes in humidity or temperature.

- Direct sunlight or room light.

- Dusty places.

- A car for a long period of time.

- An environment where corrosive gases are present.

- An environment with salty air.
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1 

Handling instructions

• Do not touch the surface of the photoconductive drum in the cartridge.

• Do not expose the cartridge to unnecessary vibrations or shock.

• Never manually rotate the drum, especially in the reverse direction; this can 
cause internal damage and toner spillage.

2 

Toner cartridge usage

Samsung Electronics does not recommend or approve the use of non-Samsung 

brand toner cartridges in your printer including generic, store brand, refilled, or 

remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine caused 
by the use of a refilled, remanufactured, or non-Samsung brand toner 
cartridges.

 

3 

Estimated cartridge life

Estimated cartridge life the life of the toner cartridge (or imaging unit) yield 

depends on the amount of toner that print jobs require. The actual print yield 

may vary depending on the print density of the pages you print on, operating 

environment, percentage of image area, printing interval, media type and/or 

media size. For example, if you print a lot of graphics, the consumption of the 

toner is higher and you may need to change the cartridge more often.
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Redistributing toner

When the toner cartridge is near the end of its life:

• White streaks or light printing occurs and/or density varies from side to side.

• The Toner LED blinks orange. The toner-related message saying that the toner is low may appear on the display. 

• The computer’s Samsung Printing Status program window appears on the computer telling you which color cartridge is low on toner (see "Using Samsung 
Printer Status" on page 158).

If this happens, you can temporarily improve print quality by redistributing the remaining toner in the cartridge. In some cases, white streaks or light printing will still 

occur even after you have redistributed the toner.

 

Illustrations on this user’s guide may differ from your machine depending on its options or models. Check your machine type (see "Front view" on page 18).

 

 

• Before opening the top cover, close the output support first.

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

• Printing even after the toner empty status can cause serious damage to your machine.
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Redistributing toner
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Replacing the toner cartridge

 

• Before opening the top cover, close the output support first.

• Do not use sharp objects such as a knife or scissors to open the toner cartridge package. They might scratch the drum of the cartridge.

• If toner gets on your clothing, wipe it off with a dry cloth and wash clothing in cold water. Hot water sets toner into fabric.

• Shake the toner cartridge thoroughly, it will increase the initial print quality.

• Do not touch the green underside of the toner cartridge. Use the handle on the cartridge to avoid touching this area. 

• Printing even after the toner empty status can cause serious damage to your machine.
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Replacing the toner cartridge

When a toner cartridge has reached the end of life, the Printing Status window appears on the computer, indicating the toner cartridge needs to be placed.

1

2
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Replacing the waste toner container

When the life span of the waste toner container has expired, the Smart Panel program window appears on the computer, indicating the waste toner container needs 

to be placed. Otherwise your printer stops printing.

 

• Toner particles can be released inside the machine but it does not mean the machine is damaged. Contact a service representative when print quality problems 
occur.

• When you pull out the waste toner container out of the machine, move the container carefully not to drop it from your hands.

• Make sure that you lay the waste toner container on a flat surface so that the toner does not spill.

 

 

Do not tilt or turn over the container.
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Replacing the waste toner container

The order information is provided for optional accessories (see "Available supplies" on page 42).

2
1
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Replacing the imaging unit

When the life span of the imaging unit has expired, the Smart Panel program window appears on the computer, indicating the imaging unit needs to be placed. 

Otherwise, your machine stops printing.

 

• Don’t use sharp objects such as a knife or scissors to open the imaging unit package. You could damage the surface of the imaging unit.

• Be careful not to scratch the surface of the imaging unit.

• To prevent damage, do not expose the imaging unit to light for more than a few minutes. Cover it with a piece of paper to protect it if necessary.

• Before closing the front cover, make sure all toner cartridges are installed properly.
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Replacing the imaging unit
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Cleaning the machine

If printing quality problems occur or if you use your machine in a dusty environment, you need to clean your machine regularly to keep it in the best printing 

condition and use your machine longer.

 

• Cleaning the cabinet of the machine with cleaning materials containing large amounts of alcohol, solvents, or other strong substances can discolor or distort the 
cabinet. 

• If your machine or the surrounding area is contaminated with toner, we recommend you use a cloth or tissue dampened with water to clean it. If you use a vacuum 
cleaner, toner blows in the air and might be harmful to you.

• During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner 
specks or smearing. Cleaning the inside of the machine clears and reduces these problems.

 

4 

Cleaning the outside

Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth slightly with water, but be careful not to let any water drip onto or into the machine.

5 

Cleaning the inside

During the printing process, paper, toner, and dust particles can accumulate inside the machine. This buildup can cause print quality problems, such as toner specks 

or smearing. Cleaning the inside of the machine clears and reduces these problems.
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Cleaning the machine

 

• Use a dry lint-free cloth to clean the machine.

• If your machine has a power switch, turn the power switch off before cleaning the machine.

• Before opening the top cover, close the output support first.

 

1 

2 

2 

1
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Tips for moving & storing your machine

• When moving the machine, do not tilt or turn it upside down. Otherwise, the inside of the machine may be contaminated by toner, which can cause damage to 

the machine or reduce print quality.

• When moving the machine, make sure at least two people are holding the machine securely. 
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4. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
• Tips for avoiding paper jams 59
• Clearing paper jams 60
• Understanding the status LED 63
 

This chapter gives helpful information for what to do if you encounter an error.

If your machine has a display screen, check the message on the display screen first to solve the 
error. If you cannot find a solution to your problem in this chapter, refer to the 
Troubleshooting chapter in the Advanced User's Guide (see "Troubleshooting" on page 166).

If you cannot find a solution in the User's Guide or the problem persists, call for service. 

 



Tips for avoiding paper jams

By selecting the correct media types, most paper jams can be avoided. To avoid paper jams, refer to the following guidelines:

• Ensure that the adjustable guides are positioned correctly (see "Tray overview" on page 27).

• Do not overload the tray. Ensure that the paper level is below the paper capacity mark on the inside of the tray.

• Do not remove paper from the tray while your machine is printing.

• Flex, fan, and straighten paper before loading. 

• Do not use creased, damp, or highly curled paper.

• Do not mix paper types in a tray.

• Use only recommended print media (see "Print media specifications" on page 70).

• Perforated or embossed paper does not separate easily. Flex the sheets back and forth to loosen them, and fan them. Feed single paper from tray if there are 
multi-feeds or paper jams.

• Grain refers to the alignment of the paper fibers in a sheet of paper. Grain long paper is recommended.

• Do not use rough-edged paper.
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Clearing paper jams

 

To avoid tearing the paper, pull the jammed paper out slowly and gently. 

 

1 

In tray
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Clearing paper jams
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Inside the machine

 

The fuser area is hot. Take care when removing paper from the machine. 
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Clearing paper jams
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In exit area

 

The fuser area is hot. Take care when removing paper from the machine. 
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Understanding the status LED

The color of the LED indicates the machine's current status.

 

• Some LEDs may not be available depending on model or country (see "Control panel overview" on page 20).

• To resolve the error, look at the error message and its instructions from the troubleshooting part (see "Troubleshooting" on page 166).

• You also can resolve the error with the guideline from the computer’s Samsung Printing Status program window (see "Using Samsung Printer Status" on page 
158).

• If the problem persists, call a service representative.
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Status LED

The color of the status LED indicates the machine's current status.
 

 

Status Description

 (Status LED)

Off
• The machine is off-line.
• The machine is in power saver mode. When data is received, or any button is pressed, it switches to on-line automatically.

Blue

On The machine is on-line and can be used.

Blinking
• When the status LED slowly blinks, the machine is receiving data from the computer.
• When the status LED blinks rapidly, the machine is printing data. 

Orange

On

• A paper jam has occurred (see "Clearing paper jams" on page 60).
• The door is open. Close the door.
• There is no paper in the tray. Load paper in the tray (see "Loading paper in the tray" on page 28).
• The machine has stopped due to a major error. 
• The waste toner container is not installed in the machine, or the waste toner container is full (see "Replacing the waste toner 

container" on page 51).
• An imaging unit has almost reached its estimated cartridge life. It is recommended to replace the imaging unit.

Blinking
A minor error has occurred and the machine is waiting for the error to be cleared. When the problem is cleared, the machine 
resumes its original task. 
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Toner / Status LED

 

 

 
(Toner LED)  (Status LED)

Description

Orange

Off Blue On All toner cartridges are at normal capacity.

Blinking Blue On
Small amount of toner is left in the cartridge. The estimated cartridge life of toner is close. Prepare a new cartridge for 
replacement. You may temporarily increase the printing quality by redistributing the toner (see "Redistributing toner" on 

page 47).a

a. Some LEDs may not be available depending on model or country(see "Control panel overview" on page 20).

On Blue On The toner cartridge lifeb is totally empty. Remove the old toner cartridge and install a new one.

b. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/IEC 19798. The number of pages 
may be affected by operating environment, printing interval, media type, and media size. Some amount of toner may remain in the cartridge even when the orange LED is on and the printer stops 
printing.

On Orange On
• A toner cartridge has almost reached its estimated cartridge lifec. It is recommended to replace the toner cartridge (see 

"Replacing the toner cartridge" on page 49).

• The toner cartridge is not installed or the wrong toner cartridge is installed (see "Replacing the toner cartridge" on page 49).

c. Estimated cartridge life means the expected or estimated toner cartridge life, which indicates the average capacity of print-outs and is designed pursuant to ISO/IEC 19798. The number of pages may be affected by 
operating environment, printing interval, graphics, media type and media size. Some amount of toner may remain in the cartridge even when orange LED is on and the printer stops printing.
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WPS / Power / Eco LED

 

 

Status Description

 (WPS LED)a

a. Wireless model only (see "Features by model" on page 6).

Blue

Blinking The machine is connecting to a wireless network.

On The machine is connected to a wireless network (see "Using the WPS button" on page 108).

Off The machine is disconnected from a wireless network.

 (Power/Wake Up LED)
Blue

On The machine is in power save mode.

Off The machine is in ready mode or the machine’s power is off.

Eco Green
On Eco mode is on (see "Eco printing" on page 38).

Off Eco mode is off.
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Specifications
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General specifications

 

These specifications are subject to change without notice. To see additional specifications and information about changes to the specifications, please visit 
www.samsung.com.

 

 

Items Description

Dimensiona Width x Length x Height 382 x 309 x 211 mm (15.0 x 12.2 x 8.3 inches) 

Weighta Machine with consumables 9.96 kg (21.96 lbs)

Noise Level bc

Ready mode Background noise level

Print mode
• Color printing: Less than 46 dB (A)

• Black and white printing: Less than 48 dB (A)

Temperature Operation 10 to 30°C (50 to 86°F)

Storage (packed) -20 to 40°C (-4 to 104°F)

Humidity Operation 20 to 80% RH

Storage (packed) 10 to 90% RH

Power ratingd 110 volt models AC 110 - 127 V

220 volt models AC 220 - 240 V
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Power consumptione

Average operating mode Less than 290W

Ready mode Less than 60 W

Power save mode Less than 1.4 W

Power off modef 0.45 W

Network Standby Mode (All Port 
Activation)

Less than 1.1 W

Wireless g Module SPW-B43143S

a. Dimensions and weight are measured without other accessories.
b. Sound Pressure Level, ISO 7779. Configuration tested: basic machine installation, A4 paper, simplex printing.
c. China only: If the equipment's noise is louder than 63 db (A), the equipment should be placed in region of relatively independent advice.
d. See the rating label on the machine for the correct voltage (V), frequency (hertz) and type of current (A) for your machine.
e. The power consumption may be affected by the machine’s status, setting conditions, operating environment, and measuring equipment and method the country uses.
f. Power consumption can be completely avoided only when power cable is not connected.
g. Wireless model only (see "Features by model" on page 6).

Items Description
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Print media specifications 

 

Type Size Dimensions
Print media weight/Capacitya

Tray

Plain paper

Letter 216 x 279 mm (8.5 x 11 inches) 60 to 85 g/m2 (16 to 23 lbs bond) 

• 150 sheets of 75 g/m2 (20 lbs bond)

• Maximum stack height : 15.5mm (0.6 inches)

Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)

A4 210 x 297 mm (8.27 x 11.69 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

JIS B5 182 x 257 mm (7.17 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.83 x 8.27 inches)

A6 105 x 148 mm (4.13 x 5.83 inches)

Thick paper
Refer to the Plain paper 
section 

Refer to the Plain paper section 86 to 120 g/m2 (23 to 32 lbs bond)

• 5 sheets

Thin paper
Refer to the Plain paper 
section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)

• 150 sheets of 60 g/m2 (16 lbs bond)

• Maximum stack height : 15.5mm (0.6 inches)
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Cotton
Refer to the Plain paper 
section 

Refer to the Plain paper section 75 to 90 g/m2 (20 to 24 lbs bond)

• 150 sheets of 75 g/m2 (20 lbs bond)

• Maximum stack height : 15.5mm (0.6 inches)

Colored, 

Pre-printed, 

Recycled

Refer to the Plain paper 
section 

Refer to the Plain paper section 60 to 85 g/m2 (16 to 24 lbs bond)

• 150 sheets of 75 g/m2 (20 lbs bond)

• Maximum stack height : 15.5mm (0.6 inches)

Labelsb
Letter, Legal, Oficio, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lbs bond)

• 5 sheets 

Card stock

Letter, Legal, Oficio, US 
Folio, A4, JIS B5, ISO 
B5, Executive, A5,

Postcard 4x6

Refer to the Plain paper section 121 to 163 g/m2 (32 to 43 lbs bond)

• 5 sheets

Bond paper
Refer to the Plain paper 
section 

Refer to the Plain paper section 105 to 120 g/m2 (28 to 32 lbs bond)

• 10 sheets

Archive
Refer to the Plain paper 
section 

Refer to the Plain paper section 70 to 90 g/m2 (18.6 to 24 lbs bond)

• 100 sheets

• Maximum stack height : 15.5mm (0.6 inches)

Type Size Dimensions
Print media weight/Capacitya

Tray
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If media weight is over 120 g/m2 (32 lbs bond), load a paper into the tray one by one.

 

Glossy Photo, 

Matte Photo

Letter, A4,

Postcard 4x6

Refer to the Plain paper section 111 to 220 g/m2 (30 to 58 lbs bond)

• 1 sheets

Minimum size (custom) 76 x 152 mm (3 x 6 inches) 60 to 120 g/m2 (16 to 32 lbs bond)

Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

a. Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 
b. The smoothness of the labels used in this machine is 100 to 250 (sheffield). This means the numeric level of smoothness.

Type Size Dimensions
Print media weight/Capacitya

Tray
725. Appendix



Specifications

3 

System requirements

Microsoft® Windows®
 

 

 

• Internet Explorer 6.0 or higher is the minimum requirement for all Windows operating systems.
• Users who have administrator rights can install the software.
• Windows Terminal Services is compatible with your machine.

 

Operating system
Requirement (recommended)

CPU RAM free HDD space

Windows® XP Service Pack 3 Intel® Pentium® III 1 GHz (Pentium IV 2 GHz) 512 MB (1 GB) 1.5 GB

Windows Server® 2003 Intel® Pentium® III 1 GHz (Pentium IV 2 GHz) 512 MB (1 GB) 1.5 GB

Windows Server® 2008 Intel® Pentium® IV 1 GHz (Pentium IV 2 GHz) 512 MB (2 GB) 10 GB

Windows Vista® Intel® Pentium® IV 3 GHz 512 MB (1 GB) 15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 1 GB (2 GB) 16 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).
• DVD-R/W Drive

Windows Server® 2008 R2 Intel® Pentium® IV 1.4 GHz (x64) processors (2 GHz or faster) 512 MB (2 GB) 10 GB

Windows® 8
Windows® 8.1

Intel® Pentium® IV 1 GHz 32-bit or 64-bit processor or higher 2 GB (2 GB) 20 GB

• Support for DirectX® 9 graphics with 128 MB memory (to enable the Aero theme).
• DVD-R/W Drive

Windows Server® 2012
Windows Server® 2012 R2

Intel® Pentium® IV 1.4 GHz (x64) processors (2 GHz or faster) 512 MB (2 GB) 32GB
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Mac

 

 

Linux

 

 

Operating system
Requirements (Recommended)

CPU RAM Free HDD space

Mac OS X 10.6 • Intel® processors 1 GB (2 GB) 1 GB

Mac OS X 10.7-10.10 • Intel® processors 2 GB 4 GB

Items Requirements

Operating system

Redhat® Enterprise Linux 5, 6,7 

Fedora 12, 13, 14, 15, 16, 17, 18, 19, 20 

OpenSuSE® 11.2, 11.3, 11.4, 12.1, 12.2, 12.3, 13.1

Ubuntu 10.04, 10.10, 11.04, 11.10, 12.04, 12.10, 13.04, 13.10, 14.04

SuSE Linux Enterprise Desktop 10, 11

Debian 6, 7

Mint 13, 14, 15, 16, 17

CPU Pentium IV 2.4GHz (Intel Core™2)

RAM 512 MB (1 GB)

Free HDD space 1 GB (2 GB)
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Network environment

 

Network and wireless models only (see "Features by model" on page 6).

 

You need to set up the network protocols on the machine to use it as your network machine. The following table shows the network environments supported by the 

machine.

Items Specifications

Network interface
• Ethernet 10/100 Base-TX Wired Lan

• 802.11b/g/n Wireless LAN

Network operating system

• Windows® XP Service Pack 3, Windows Server® 2003, Windows Vista®, Windows® 7, Windows® 8, Windows Server® 2008 R2

• Various Linux OS

• Mac OS X 10.6 - 10.10

Network protocols

• TCP/IPv4

• DHCP, BOOTP

• DNS, WINS, Bonjour, SLP, UPnP

• Standard TCP/IP Printing (RAW), LPR, IPP, WSD

• SNMPv 1/2/3, HTTP

• TCP/IPv6 (DHCP, DNS, RAW, LPR, SNMPv 1/2/3, HTTP)

Wireless security 
• Authentication: Open System, Shared Key, WPA Personal, WPA2 Personal (PSK)

• Encryption: WEP64, WEP128, TKIP, AES
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Regulatory information

This machine is designed for a normal work environment and certified with 

several regulatory statements.

5 

Laser safety statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 

CFR, chapter 1 Subchapter J for Class I (1) laser products, and elsewhere is 

certified as a Class I laser product conforming to the requirements of IEC 60825-

1 : 2007.

Class I laser products are not considered to be hazardous. The laser system and 

printer are designed so there is never any human access to laser radiation above 

a Class I level during normal operation, user maintenance or prescribed service 

condition.

Warning 

Never operate or service the printer with the protective cover removed from 

laser/scanner assembly. The reflected beam, although invisible, can damage 

your eyes.

When using this product, these basic safety precautions should always be 

followed to reduce risk of fire, electric shock, and injury to persons:
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6 

Ozone safety

7 

Perchlorate warning

This Perchlorate warning applies only to primary CR (Manganese Dioxide) 

Lithium coin cells in the product sold or distributed ONLY in California USA. 

Perchlorate Material - special handling may apply.

See www.dtsc.ca.gov/hazardouswaste/perchlorate. (U.S.A. only)

8 

Power saver

9 

Recycling

This product’s ozone emission rate is under 0.1 ppm. Because 
ozone is heavier than air, keep the product in a place with good 
ventilation.

This printer contains advanced energy conservation technology that 
reduces power consumption when it is not in active use.

When the printer does not receive data for an extended period of 
time, power consumption is automatically lowered. 

ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 

For more information on the ENERGY STAR program see http://
www.energystar.gov

For ENERGY STAR certified models, the ENERGY STAR label will be on 
your machine. Check if your machine is ENERGY STAR certified.

Recycle or dispose of the packaging material for this product in an 
environmentally responsible manner.
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10 

Correct disposal of this product (Waste electrical & 
electronic equipment)

(Applicable in countries with separate collection 
systems)

(The United States of America only)
Dispose unwanted electronics through an approved recycler. To find the nearest 
recycling location, go to our website: www.samsung.com/recyclingdirect Or 
call, (877) 278 - 0799

11 

State of California Proposition 65 Warning (US Only)

12 

Radio frequency emissions

FCC information to the user

This device complies with Part 15 of the FCC Rules. Operation is subject to the 

following two conditions: 

• This device may not cause harmful interference, and

• This device must accept any interference received, including interference 
that may cause undesired operation.

This marking on the product, accessories or literature indicates that the 
product and its electronic accessories (e.g. charger, headset, USB cable) 
should not be disposed of with other household waste at the end of 
their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these 
items from other s of waste and recycle them responsibly to promote the 
sustainable reuse of material resources.

Household users should contact either the retailer where they 
purchased this product, or their local government office, for details of 
where and how they can take these items for environmentally safe 
recycling.

Business users should contact their supplier and check the terms and 
conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for 
disposal.
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This equipment has been tested and found to comply with the limits for a Class 

B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 

to provide reasonable protection against harmful interference in a residential 

installation. This equipment generates, uses and can radiate radio frequency 

energy and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is no 

guarantee that interference will not occur in a particular installation. If this 

equipment does cause harmful interference to radio or television reception, 

which can be determined by turning the equipment off and on, the user is 

encouraged to try to correct the interference by one or more of the following 

measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer 
responsible for compliance could void the user's authority to operate the 
equipment.

 

Canadian radio interference regulations

This digital apparatus does not exceed the Class B limits for radio noise 

emissions from digital apparatus as set out in the interference-causing 

equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and 

Science Canada.

Cet appareil numérique respecte les limites de bruits radioélectriques 

applicables aux appareils numériques de Classe B prescrites dans la norme sur le 

matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et 

Sciences Canada.

13 

RFID (Radio Frequency Interface Device)

RFID operation is subject to the following two conditions:(1) this device may not 

cause interference, and (2) this device must accept any interference, including 

interference that may cause undesired operation of the device. (U.S.A., France, 

Taiwan only)
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United States of America

Federal Communications Commission (FCC)

Intentional emitter per FCC Part 15

Low power, Radio LAN devices (radio frequency (RF) wireless communication 

devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 

your printer system. This section is only applicable if these devices are present. 

Refer to the system label to verify the presence of wireless devices.

Wireless devices that may be in your system are only qualified for use in the 

United States of America if an FCC ID number is on the system label.

The FCC has set a general guideline of 20 cm (8 inches) separation between the 

device and the body, for use of a wireless device near the body (this does not 

include extremities). This device should be used more than 20 cm (8 inches) 

from the body when wireless devices are on. The power output of the wireless 

device (or devices), which may be embedded in your printer, is well below the 

RF exposure limits as set by the FCC.

This transmitter must not be collocated or operation in conjunction with any 

other antenna or transmitter.

Operation of this device is subject to the following two conditions: (1) This 

device may not cause harmful interference, and (2) this device must accept any 

interference received, including interference that may cause undesired 

operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. 
Modification to a wireless device will void the authorization to use it. 
Contact manufacturer for service.

 

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination 

the radio frequency exposure limit of 1 mW/cm2 may be exceeded at 
distances close to the antenna installed. Therefore, the user must maintain 
a minimum distance of 20 cm from the antenna at all times. This device 
cannot be collocated with another transmitter and transmitting antenna.

 

15 

Replacing the Fitted Plug (for UK Only)

Important

The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug 

and has a 13 amp fuse. When you change or examine the fuse, you must re-fit 

the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost 

the fuse cover, do not use the plug until you have another fuse cover. 

Contact the people from you purchased the machine.
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The 13 amp plug is the most widely used in the UK and should be suitable. 

However, some buildings (mainly old ones) do not have normal 13 amp plug 

sockets. You need to buy a suitable plug adaptor. Do not remove the moulded 

plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you 
plug it into a socket.

 

Important warning: 

If the wires in the mains lead do not match the colors marked in your plug, do 

the following:

You must connect the green and yellow wire to the pin marked by the letter “E” 

or by the safety ‘Earth symbol’ or colored green and yellow or green.

You must connect the blue wire to the pin which is marked with the letter “N” or 

colored black.

You must connect the brown wire to the pin which is marked with the letter “L” 

or colored red.

You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.

16 

Declaration of conformity (European countries)

Approvals and Certifications

January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of 

the member states related to low voltage equipment.

January 1, 1996: Council Directive 2004/108/EC, approximation of the laws of 

the Member States related to electromagnetic compatibility.

You must earth this machine.

The wires in the mains lead have the following color code:

• Green and Yellow: Earth

• Blue: Neutral

• Brown: Live

Hereby, Samsung Electronics, declares that this [C43x series] is in 
compliance with the essential requirements and other relevant 
provisions of Low Voltage Directive (2006/95/EC), EMC Directive 
(2004/108/EC).

Hereby, Samsung Electronics, declares that this [C43xW series] is in 
compliance with the essential requirements and other relevant 
provisions of R&TTE Directive 1999/5/EC.

The declaration of conformity may be consulted at 
www.samsung.com, go to Support > Download center and enter 
your printer (MFP) name to browse the EuDoC. 
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March 9, 1999: Council Directive 1999/5/EC on radio equipment and 

telecommunications terminal equipment and the mutual recognition of their 

conformity. A full declaration, defining the relevant Directives and referenced 

standards can be obtained from your Samsung Electronics Co., Ltd. 

representative.

EC Certification

Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal 

Equipment Directive (FAX)

This Samsung product has been self-certified by Samsung for pan-European 

single terminal connection to the analogue public switched telephone network 

(PSTN) in accordance with Directive 1999/5/EC. The product has been designed 

to work with the national PSTNs and compatible PBXs of the European 

countries:

In the event of problems, you should contact the Euro QA Lab of Samsung 

Electronics Co., Ltd. in the first instance.

The product has been tested against TBR21. To assist in the use and application 

of terminal equipment which complies with this standard, the European 

Telecommunication Standards Institute (ETSI) has issued an advisory document 

(EG 201 121) which contains notes and additional requirements to ensure 

network compatibility of TBR21 terminals. The product has been designed 

against, and is fully compliant with, all of the relevant advisory notes contained 

in this document.

European radio approval information (for products 
fitted with EU-approved radio devices)

Low power, Radio LAN type devices (radio frequency (RF) wireless 

communication devices), operating in the 2.4 GHz/5 GHz band, may be present 

(embedded) in your printer system which is intended for home or office use. This 

section is only applicable if these devices are present. Refer to the system label 

to verify the presence of wireless devices.

The power output of the wireless device or devices that may be embedded in 

you printer is well below the RF exposure limits as set by the European 

Commission through the R&TTE directive.

European states qualified under wireless approvals:

EU countries

European states with restrictions on use:

EU

In France, this equipment may only be used indoors.

EEA/EFTA countries

Wireless devices that may be in your system are only qualified for 
use in the European Union or associated areas if a CE mark with a 
Notified Body Registration Number and the Alert Symbol is on the 
system label.
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No limitations at this time
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Regulatory compliance statements

Wireless guidance

Low power, Radio LAN devices (radio frequency (RF) wireless communication 

devices), operating in the 2.4 GHz/5 GHz Band, may be present (embedded) in 

your printer system. The following section is a general overview of 

considerations while operating a wireless device.

Additional limitations, cautions, and concerns for specific countries are listed in 

the specific country sections (or country group sections). The wireless devices in 

your system are only qualified for use in the countries identified by the Radio 

Approval Marks on the system rating label. If the country you will be using the 

wireless device in, is not listed, contact your local Radio Approval agency for 

requirements. Wireless devices are closely regulated and use may not be 

allowed.

The power output of the wireless device or devices that may be embedded in 

your printer is well below the RF exposure limits as known at this time. Because 

the wireless devices (which may be embedded into your printer) emit less 

energy than is allowed in radio frequency safety standards and 

recommendations, manufacturer believes these devices are safe for use. 

Regardless of the power levels, care should be taken to minimize human contact 

during normal operation.

As a general guideline, a separation of 20 cm (8 inches) between the wireless 

device and the body, for use of a wireless device near the body (this does not 

include extremities) is typical. This device should be used more than 20 cm (8 

inches) from the body when wireless devices are on and transmitting.

This transmitter must not be collocated or operation in conjunction with any 

other antenna or transmitter.

Some circumstances require restrictions on wireless devices. Examples of 

common restrictions are listed below:

Radio frequency wireless communication can interfere with 
equipment on commercial aircraft. Current aviation regulations 
require wireless devices to be turned off while traveling in an airplane. 
IEEE 802.11 (also known as wireless Ethernet) and Bluetooth 
communication devices are examples of devices that provide wireless 
communication.

In environments where the risk of interference to other devices or 
services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and 
Oxygen or flammable gas laden atmospheres are limited examples 
where use of wireless devices may be restricted or eliminated. When in 
environments where you are uncertain of the sanction to use wireless 
devices, ask the applicable authority for authorization prior to use or 
turning on the wireless device.
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Taiwan only

19 

Taiwan only

20 

Russia / Kazakhstan / Belarus only

Every country has different restrictions on the use of wireless devices. 
Since your system is equipped with a wireless device, when traveling 
between countries with your system, check with the local Radio 
Approval authorities prior to any move or trip for any restrictions on 
the use of a wireless device in the destination country.

If your system came equipped with an internal embedded wireless 
device, do not operate the wireless device unless all covers and shields 
are in place and the system is fully assembled.

Wireless devices are not user serviceable. Do not modify them in any 
way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

Only use drivers approved for the country in which the device will be 
used. See the manufacturer System Restoration Kit, or contact 
manufacturer Technical Support for additional information.
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21 

Germany only

22 

Turkey only

23 

Thailand only

This telecommunication equipment conforms to NTC technical requirement.

24 

China only

Website: http://www.samsung.com/cn/support/location/
supportServiceLocation.do?page=SERVICE.LOCATION
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Copyright

© 2015 Samsung Electronics Co., Ltd. All rights reserved.

This user’s guide is provided for information purposes only. All information included herein is subject to change without notice.

Samsung Electronics is not responsible for any direct or indirect damages, arising from or related to use of this user’s guide.

• Samsung and the Samsung logo are trademarks of Samsung Electronics Co., Ltd.

• Microsoft, Windows, Windows Vista, Windows 7, Windows 8, and Windows Server 2008 R2 are either registered trademarks or trademarks of Microsoft 
Corporation.

• Microsoft, Internet Explorer, Excel, Word, PowerPoint, and Outlook are either registered trademarks or trademarks of Microsoft Corporation in the United States 
and other countries.

• Google, Picasa, Google Docs, Android and Gmail are either registered trademarks or trademarks of Google Inc.

• iPad, iPhone, iPod touch, Mac and Mac OS are trademarks of Apple Inc., registered in the U.S and other countries.

• AirPrint and the AirPrint logo are trademarks of Apple Inc.

• All other brand or product names are trademarks of their respective companies or organizations.
 

 

REV. 2.00

QR code

The software included in this product contains open source software. You may obtain the complete 
corresponding source code for a period of three years after the last shipment of this product by sending an email 
to mailto:oss.request@samsung.com. It is also possible to obtain the complete corresponding source code in a 
physical medium such as a CD-ROM; a minimal charge will be required.

The following URL https://opensource.samsung.com/opensource/Samsung_C43x_Series/seq/49 leads to 
the download page of the source code made available and open source license information as related to 
this product. This offer is valid to anyone in receipt of this information.
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1. Software Installation
This chapter provides instructions for installing essential and helpful software for use in an environment where the 
machine is connected via a cable. A locally connected machine is a machine directly attached to your computer using a 
USB cable. If your machine is attached to a network, skip the following steps below and go on to installing a network 
connected machine’s driver (see Installing driver over the network100).
• Installation for Mac 91
• Reinstallation for Mac 92
• Installation for Linux 93
• Reinstallation for Linux 94
 

• If you are a Windows OS user, refer to the "Installing the driver locally" on page 23 for 
installing the machine’s driver.

• Only use a USB cable no longer then 3 meter (118 inches).

 



Installation for Mac

1 Make sure that the machine is connected to your computer and 

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click the Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next and then follow the instructions in the installation window.

 

To install the fax driver: 

a Open the Applications folder > Samsung > Fax Queue Creator.

b Your machine appears on the Printer List
c Select machine to use and click Create button
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Reinstallation for Mac

If the printer driver does not work properly, uninstall the driver and reinstall it.

1 Open the Applications folder > Samsung > Printer Software 
Uninstaller.

2 To uninstall printer software, click Continue.

3 Check the program you want to delete and click Uninstall.

4 Enter the password and click OK.

5 After the uninstallation is finished, click Close.

 

If a machine has already been added, delete it from the Print Setup Utility 
or Print & Fax.
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Installation for Linux

You need to download Linux software packages from the Samsung website to 

install the printer software (http://www.samsung.com > find your product > 

Support or Downloads).

1 

Installing the Unified Linux Driver

 

You must log in as a super user (root) to install the machine software. If you 
are not a super user, ask your system administrator.

 

1 Make sure that the machine is connected to your computer and 
powered on.

2 Copy Unified Linux Driver package to your system.

3  Open Terminal program and go to the folder that you copied the 
package to.

4 Extract the package.

5 Move to uld folder.

6 Execute "./install.sh" command (If you're not logged in as root, execute 
the command with "sudo" as "sudo ./install.sh")

7  Proceed with installation.

8 When installation finished, launch printing utility(Go to System > 
Administration > Printing or execute "system-config-printer" 
command in Terminal program).

9 Click Add button.

10 Select your printer.

11 Click Forward button and add it to your system.
931.  Software Installation
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Reinstallation for Linux

If the printer driver does not work properly, uninstall the driver and reinstall it.

1  Open Terminal program.

2 Move to uld folder extracted from Unified Linux Driver package.

3 Execute "./uninstall.sh" command (If you're not logged in as root, 
execute the command with "sudo" as "sudo ./uninstall.sh")

4 Proceed with uninstallation.
941.  Software Installation



2. Using a Network-
Connected Machine

This chapter gives you step-by-step instructions for setting up a network connected machine and software.
• Useful network programs 96
• Wired network setup 97
• Installing driver over the network 100
• IPv6 configuration 105
• Wireless network setup 107
• Samsung Mobile Print 124
• Using the NFC feature 125
• Mopria™ 127
• AirPrint 129
 

Supported optional devices and features may differ according to your model (see "Features by 
model" on page 6).

 



Useful network programs

There are several programs available to setup the network settings easily in a 

network environment. For the network administrator especially, managing 

several machines on the network is possible. 

 

• Before using the programs below, set the IP address first. 

• Some features and optional goods may not be available depending on 
model or country (see "Features by model" on page 6).

 

1 

SyncThru™ Web Service

The web server embedded on your network machine allows you to do the 

following tasks (see "Using SyncThru™ Web Service" on page 153).

• Check the supplies information and status.

• Customize machine settings.

• Set the email notification option. When you set this option, the machine 
status (toner cartridge shortage or machine error) will be sent to a certain 
person's email automatically.

• Configure the network parameters necessary for the machine to connect to 
various network environments.

2 

SetIP wired network setup

This utility program allows you to select a network interface and manually 

configure the IP addresses for use with the TCP/IP protocol.

• See "IPv4 configuration using SetIP (Windows)" on page 97.

• See "IPv4 configuration using SetIP (Mac)" on page 98.

• See "IPv4 configuration using SetIP (Linux)" on page 98.

 

• If your device does not support a network connection, it will not be able

to use this feature (see "Rear view" on page 19).

• TCP/IPv6 is not supported by this program.
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Wired network setup

3 

Printing a network configuration report

You can print Network Configuration Report from the machine’s control panel 

that will show the current machine’s network settings. This will help you to set 

up a network.

Press the  (Cancel or Stop/Clear) button for two seconds on the control 

panel.

Using this Network Configuration Report, you can find your machine’s MAC 

address and IP address.

For example:

• MAC Address: 00:15:99:41:A2:78

• IP Address: 169.254.192.192

4 

Setting IP address

 

• If your device does not support a network connection, it will not be able

to use this feature (see "Rear view" on page 19).

• TCP/IPv6 is not supported by this program.

 

First, you have to set up an IP address for network printing and managements. 

In most cases a new IP address will be automatically assigned by a DHCP 

(Dynamic Host Configuration Protocol) server located on the network.

IPv4 configuration using SetIP (Windows)

Before using the SetIP program, disable the computer firewall from Control 
Panel > Security Center > Windows Firewall.

 

The following instructions may differ for your model. 

 

1 Download the software from the Samsung website then unpack and 
install it: (http://www.samsung.com > find your product > Support or 
Downloads).

2 Follow the instructions in the installation window.

3 Connect your machine to the network with a network cable.

4 Turn on the machine.

5 From the Windows Start menu, select All Programs > Samsung 
Printers > SetIP > SetIP.

6 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.
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7 Enter the machine’s new information into the configuration window. In 

a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 97) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

8 Click Apply, and then click OK. The machine will automatically print the 
Network Configuration Report. Confirm that all the settings are 
correct.

IPv4 configuration using SetIP (Mac)

Before using the SetIP program, disable the computer firewall from System 
Preferences > Security (or Security & Privacy) > Firewall.

1 Download the software from the Samsung website then unpack and 
install it: (http://www.samsung.com > find your product > Support or 
Downloads).

2 Turn on the machine.

3 Run downloaded SetIP application

4 Click the  icon (third from left) in the SetIP window to open the TCP/
IP configuration window.

5 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 97) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

6 Click Apply, and then click OK. The machine will automatically print the 
Network Configuration Report. Confirm that all the settings are 
correct.

IPv4 configuration using SetIP (Linux)

Before using the SetIP program, disable the computer firewall from System 
Preferences or Administrator.

 

The following instructions may vary from your model or operating systems.
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1 Download SetIP program from Samsung web site and extract it.

2 Double-click the SetIPApplet.html file in cdroot/Linux/noarch/
at_opt/share/utils folder. 

3 Click to open the TCP/IP configuration window. 

4 Enter the machine’s new information into the configuration window. In 
a corporate intranet, you may need to have this information assigned by 
a network manager before proceeding.

 

Find the machine’s MAC address from the Network Configuration Report 
(see "Printing a network configuration report" on page 97) and enter it 
without the colons. For example, 00:15:99:29:51:A8 becomes 
0015992951A8.

 

5 The machine will automatically print the Network Configuration 
Report. 
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• Some features and optional goods may not be available depending on 
model or country (see "Features by model" on page 6).

• The machine that does not support the network interface, it will not be 
able to use this feature (see "Rear view" on page 19).

• You can install the printer driver and software when you insert the 
software CD into your CD-ROM drive.

For windows, select the printer driver and software in the Select 
Software to Install window.

 

5 

Windows

 

The firewall software might be blocking network communication. Before 
connecting the device to the network, disable the computer’s firewall.

 

1 Make sure that the machine is connected to the network and powered 
on. Also, your machine’s IP address should have been set (see "Setting IP 
address" on page 97).

2 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

 X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3 Review and accept the installation agreements in the installation 
window. Then, click Next.

4 Select Network on the Printer Connection Type screen Then,

click Next.

5 Follow the instructions in the installation window.
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From the Windows 8 Start Screen

 

• The V4 driver is automatically downloaded from the Windows Update if 
your computer is connected to the Internet. If not, you can manually 
download the V4 driver from Samsung website, http://
www.samsung.com > find your product > Support or downloads. 

• You can download Samsung Printer Experience app from the 
Windows Store. You need have a Microsoft account to use the Windows 
Store.

a From Charms, select Search. 

b Click Store.

c Search and click Samsung Printer Experience.

d Click Install.

• If you install the driver using the supplied software CD, V4 driver is not 
installed. If you want to use the V4 driver in the Desktop screen, you can 
download from the Samsung website, http://www.samsung.com >find 
your product > Support or downloads.

• If you want to install Samsung’s printer management tools, you need to 
install them using the supplied software CD.

 

1 Make sure that the machine is connected to the network and powered 
on. Also, your machine’s IP address should have been set (see "Setting IP 
address" on page 97). 

2 From Charms, select Settings > Change PC settings > Devices.

3 Click Add a device. 

Discovered machines will be shown on the screen. 

4 Click the model name or host name you wish to use. 

 

You can print a Network Configuration Report from the machine’s control 
panel that will show the current machine’s host name (see "Printing a 
network configuration report" on page 117).

 

5 The driver is automatically installed from the Windows Update. 

Silent installation Mode

Silent installation mode is an installation method that does not require any user 

intervention. Once you start the installation, the machine driver and software 

are automatically installed on you computer. You can start the silent installation 

by typing /s or /S in the command window.

Command-line Parameters

Following table shows commands that can be used in the command window.

 

Following command-line are effective and operated when command is 
used with /s or /S. But /h, /H or /? are exceptional commands that can be 
operated solely.
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Command- line Definition Description

/s or

/S

Starts silent installation. Installs machine drivers 
without prompting any UIs 
or user intervention.

/p”<port name>” or

/P”<port name>”

Specifies printer port.

 

Network Port will be 
created by use of 
Standard TCP/IP 
Port monitor. For 
local port, this port 
must exist on 
system before 
being specified by 
command.

 

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port 
name.

For example:

•  /p”xxx.xxx.xxx.xxx” in 
where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. /
p”USB001”, /P”LPT1:”, /
p”hostname”

/a”<dest_path>” or

/A”<dest_path>”

Specifies destination path 
for installation.

 

The destination 
path should be a 
fully qualified path.

 

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.

/n”<Printer name>” 
or

/N”<Printer name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you 
can add printer instances as 
you wish.

/nd or

/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed 
machine driver will not be 
the default machine driver 
on your system if there are 
one or more printer drivers 
installed. If there is no 
installed machine driver on 
your system, then this 
option won’t be applied 
because Windows OS will 
set installed printer driver as 
a default machine driver.

/x or

/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional 
driver.

Command- line Definition Description
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6 

Mac

1 Make sure that the machine is connected to your computer and 
powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click the Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next.

7 Select Network on the printer connection type screen. 

8 Click Next.

9 Follow the instructions in the installation window.

7 

Linux

You need to download Linux software packages from the Samsung website to 

install the printer software (http://www.samsung.com  > find your product > 

Support or Downloads).

/up”<printer 
name>” or

/UP”<printer 
name>”

Removes only specified 
printer instance and not the 
driver files.

This command provides a 
way to remove only 
specified printer instance 
from your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from your 
system.

/d or

/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove 
all installed device drivers 
and application software 
from your system.

/v”<share name>” or

/V”<share name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

/o or 

/O

Opens Printers and Faxes 
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

/h, /H or /? Shows Command-line Usage.

Command- line Definition Description
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1 Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 

2 Copy Unified Linux Driver package to your system.

3 Open Terminal program and go to the folder that you copied the

package to.

4 Extract the package.

5 Move to uld folder.

6 Execute ” ./install.sh“ command (If you are not logged in as root,

execute the command with “sudo” as “sudo ./install.sh”).

7 Proceed with installation.

8 When installation finished, launch Printing utility (Go to System > 
Administration > Printing or execute “system-config-printer“ 
command in Terminal program).

9 Click Add button.

10 Select AppSocket/HP JetDirect and enter your machine’s IP address.

11 Click Forward button and add it to your system.
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IPv6 is supported properly only in Windows Vista or higher.

 

 

If the IPv6 network seems to not be working, set all the network setting to 
the factory defaults and try again using Clear Setting.

 

The machine supports the following IPv6 addresses for network printing and 

managements.

• Link-local Address: Self-configured local IPv6 address (Address starts with 
FE80).

• Stateless Address: Automatically configured IPv6 address by a network 
router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

In the IPv6 network environment, follow the next procedure to use the IPv6 

address.

8 

From the SyncThru™ Web Service

Activating IPv6

1 Access a web browser, such as Internet Explorer, from Windows. Enter 
the machine IP address (http://xxx.xxx.xxx.xxx) in the address field and 
press the Enter key or click Go.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

3 When the SyncThru™ Web Service window opens, move the mouse 
cursor over the Settings of the top menu bar and then click Network 
Settings.

4 Click TCP/IPv6 on the left pane of the website.

5 Check the IPv6 Protocol check box to activate IPv6.

6 Click the Apply button.

7 Turn the machine off and turn it on again.
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• You can also set the DHCPv6.

• To manually set the IPv6 address:

Check the Manual Address check box. Then, the Address/Prefix text 
box is activated. Enter the rest of the address 
(e.g.,:3FFE:10:88:194::AAAA. “A” is the hexadecimal 0 through 9, A 
through F).

 

IPv6 address configuration

1 Start a web browser, such as Internet Explorer, that supports IPv6 
addressing as a URL.

2 Select one of the IPv6 addresses (Link-local Address, Stateless 
Address, Stateful Address, Manual Address) from Network 
Configuration Report (see "Printing a network configuration report" on 
page 97).

• Link-local Address: Self-configured local IPv6 address (Address 
starts with FE80).

• Stateless Address: Automatically configured IPv6 address by a 
network router.

• Stateful Address: IPv6 address configured by a DHCPv6 server.

• Manual Address: Manually configured IPv6 address by a user.

3 Enter the IPv6 addresses (e.g.,: http://[FE80::215:99FF:FE66:7701]).

 

Address must be enclosed in '[ ]' brackets.
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• Wireless networking may not be available depending on the model (see 
"Features by model" on page 6).

 

Wireless networks require higher security, so when an access point is first set up, 

a network name (SSID), the type of security used, and a Network Password are 

created for the network. Ask your network administrator about this information 

before proceeding with the machine installation.

9 

Introducing wireless set up methods

You can set wireless settings either from the machine or the computer. Choose 

the setting method from the below table.

 

• Some wireless network installation types may not be available 
depending on the model or country.

• It is strongly recommended that you set the password on Access Points. 
If you do not set the password on Access Points, they might be exposed 
to illegal access from unknown machines including PCs, smart phones 
and printers. Refer to the Access Point user' guide for password settings.

 

Set up 
method

Connecting 
method

Description & Reference

With Access 
Point

From the 
computer

See "Setting up via USB cable" on page 111 
for Window.

See "Access point without a USB cable" on 
page 113 for Window.

See "Setting up via USB cable" on page 115 
for Mac.

See "Access point without a USB cable" on 
page 116 for Mac.

See "Using a network cable" on page 117.

From the 
machine’s control 
panel

See "Using the WPS button" on page 108.

Wi-Fi Direct setup
See "Setting the Wi-Fi Direct for mobile 
printing" on page 119.
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Using the WPS button 

If your machine and access point (or wireless router) support Wi-Fi Protected 

Setup™ (WPS), then you can easily configure the wireless network settings 

through the WPS button menu without the need for a computer.

 

• If you want to use the wireless network using the infrastructure mode, 
make sure that the network cable is disconnected from the machine. 
Using the WPS (PBC) button or entering the PIN from the computer to 
connect to the access point (or wireless router) varies depending on the 
access point (or wireless router) you are using. Refer to the user's guide 
of the access point (or wireless router) you are using.

• When using the WPS button to set the wireless network, security settings 
may change. To prevent this, lock the WPS option for the current wireless 
security settings. The option name may differ depending on the access 
point (or wireless router) you are using.

 

Items to prepare

• Check if the access point (or wireless router) supports Wi-Fi Protected 
Setup™ (WPS).

• Check if your machine supports Wi-Fi Protected Setup™ (WPS).

• Networked computer (PIN mode only)

Choosing your type

There are two methods available to connect your machine to a wireless network.

• The Push Button Configuration (PBC) method allows you to connect your 
machine to a wireless network by pressing both the WPS  button menu on 
the control panel of your machine and the WPS (PBC) button on a Wi-Fi 
Protected Setup™ WPS-enabled access point (or wireless router) 
respectively.

• The Personal Identification Number (PIN) method helps you connect your 
machine to a wireless network by entering the supplied PIN information on 
a Wi-Fi Protected Setup™ WPS-enabled access point (or wireless router).
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Connecting WPS

Factory default in your machine is PBC mode, which is recommended for a 

typical wireless network environment.

Connecting in PBC mode

1 Press and hold the  (WPS) button on the control panel for about 2 - 4 
seconds until the status LED blinks quickly.

The machine starts connecting to the wireless network. The LED blinks 
slowly for up to two minutes until you press the PBC button on the 
access point (or wireless router).

2 Press the WPS (PBC) button on the access point (or wireless router).

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router). 

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

3 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.

Connecting in PIN mode

1 The network configuration report, including PIN, must be printed (see 
"Printing a network configuration report" on page 97).

In ready mode, press and hold the  (Cancel or Stop/Clear) button on 
the control panel for about 5 seconds. You can find your machine’s PIN.

2 Press and hold the  (WPS) button on the control panel for more than 
4 seconds until the status LED stays on.

The machine starts connecting to the access point (or wireless router).

3 You need to enter the eight-digit PIN within two minutes on the 
computer that is connected to the access point (or wireless router).

The LED blinks slowly for up to two minutes until you enter the eight-
digit PIN.

The WPS LED blinks in the order below:

a The light blinks fast on the WPS LED. The machine is connecting to 
the access point (or wireless router).

b When the machine is successfully connected to the wireless 
network, the WPS LED light stays on.

4 Insert the supplied software CD into your CD-ROM drive, and follow the 
instructions in the window to set up the wireless network.
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Re-connecting to a network

When the wireless function is off, the machine automatically tries to re-connect 

to the access point (or wireless router) with the previously used wireless 

connection settings and address.

 

In the following cases, the machine automatically re-connects to the 
wireless network:

• The machine is turned off and on again.

• The access point (or wireless router) is turned off and on again.

 

Canceling the connection process

To cancel the wireless network connection when the machine is connecting to 

the wireless network, press and release the  (Cancel or Stop/Clear) on the 

control panel. You need to wait 2 minutes to re-connect to the wireless 
network.

Disconnecting from a network

To disconnect the wireless network connection, press the  (WPS) button on 

the control panel for more than two seconds.

• When the Wi-Fi network is in idle mode: The machine is immediately 
disconnected from the wireless network and the WPS LED turns off.

• When the Wi-Fi network is being used: While the machine waits until the 
current job is finished, the light blinks fast on the WPS LED. Then, the 
wireless network connection is automatically disconnected and the WPS 
LED turns off.

11 

Setup using Windows

 

Shortcut to the Samsung Easy Wireless Setup program without the CD: If 
you have installed the printer driver once, you can access the Samsung 
Easy Wireless Setup program without the CD.
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Setting up via USB cable

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Creating the infrastructure network

1 Check wheter the USB cable is connected to the machine.

2 Turn on your computer, access point, and machine.

3 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

4 Review and accept the installation agreements in the installation 
window. Then, click Next.

5 Select Wireless on the Printer Connection Type screen. Then, click 
Next.
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6 On the Are you setting up your printer for the first time? screen, select 

Yes, I will set up my printer's wireless network. Then, click Next.

If your printer is already connected on the network, select No, my 
printer is already connected to my network.

7 Select Using a USB cable on the Select the Wireless Setup Method 
screen. Then, click Next.

8 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

 

If you cannot find the network name you want to choose, or if you want to 
set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.

• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.

Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on a WPA Pre-Shared Key. This uses a shared secret key 
(generally called Pre Shared Key pass phrase), which is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption (None, WEP64, WEP128, TKIP, AES, 
TKIP AES).

• Network Password: Enter the encryption network password value.

• Confirm Network Password: Confirm the encryption network 
password value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

 

 

The wireless network security window appears when the access point has 
security settings.

Enter the Network Password of the access point (or router).
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9 If your printer supports Wi-Fi Direct, the following screen appears.

Click Next.

 

• Wi-Fi Direct option appears on the screen only if your printer supports 
this feature.

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 119).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

10 When the wireless network set up is completed, disconnect the USB 
cable between the computer and machine. Click Next.

11 Select the components to be installed.

12 Follow the instructions in the installation window.

Access point without a USB cable

Items to prepare

• WiFi-enabled PC running Windows 7 or higher and an access point (router)

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

 

While setting the wireless network, the machine uses PC's wireless LAN. You 
might not be able to connect to the Internet. 
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Creating the infrastructure network

1 Turn on your computer, access point, and machine.

2 Insert the supplied software CD into your CD-ROM drive.

If the installation window does not appear, click Start > All programs > 
Accessories > Run.

X:\Setup.exe replacing “X” with the letter, which represents your CD-
ROM drive and click OK.

• For Windows 8,

If the installation window does not appear, from Charms, select 
Search > Apps and search for Run. Type in X:\Setup.exe, replacing 
“X” with the letter that represents your CD-ROM drive and click OK.

If “Tap to choose what happens with this disc.” pop-up window 
appears, click the window and select Run Setup.exe.

3 Review and accept the installation agreements in the installation 
window. Then, click Next.

4 Select Wireless on the Printer Connection Type screen. Then, click 
Next.

5 On the Are you setting up your printer for the first time? screen, select 
Yes, I will set up my printer's wireless network. Then, click Next.

If your printer is already connected on the network, select No, my 
printer is already connected tomy network.

6 Select Using a direct wireless connection on the Select the Wireless 
Setup Method screen. Then, click Next.

 

• Even if your computer is running Windows 7 or higher, you cannot use 
this feature if your PC does not support wireless network. Set the wireless 
network using a USB cable (see "Setting up via USB cable" on page 111).

• If below screen appears, press the  (WPS) button from the control 
panel within 2 minutes.
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7 When the wireless network set up is completed, click Next. 

8 Follow the instructions in the installation window.

12 

Setup using Mac

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• USB cable

Setting up via USB cable

1 Make sure that the machine is connected to your computer and

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next

7 Select Wireless on the Printer Connection Type

8 Click Next

9 If the installer asks you to allow access to the keychain, click Deny.

 

If you clicked Always Allow in this step, the Select a wireless printer 
window appears without asking for access to the keychain. If this occurs, 
click Cancel in the Select a wireless printer window.

 

10 On the Select the Wireless Setup Method screen, select Using a USB 
cable, and then click Next.

If the screen dose not appear, go to step 14.

11 After searching, the window shows the wireless network devices. Select 
the name (SSID) of the access point you want to use and click Next.

 

When you set the wireless configuration manually, click Advanced Setting.

• Enter the wireless Network Name: Enter the SSID of the access point 
(SSID is case-sensitive).

• Operation Mode: Select Infrastructure.
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• Authentication: Select an authentication type.

Open System: Authentication is not used, and encryption may or may 
not be used, depending on the need for data security.

Shared Key: Authentication is used. A device that has a proper WEP key 
can access the network.

WPA Personal or WPA2 Personal: Select this option to authenticate the 
print server based on the WPA Pre-Shared Key. This uses a shared secret 
key (generally called Pre Shared Key pass phrase) that is manually 
configured on the access point and each of its clients.

• Encryption: Select the encryption. (None, WEP64, WEP128, TKIP, AES)

• Network Key: Enter the encryption network key value.

• Confirm Network Key: Confirm the encryption network key value.

• WEP Key Index: If you are using WEP Encryption, select the appropriate 
WEP Key Index.

The wireless network security window appears when the access point has 
security enabled.

Enter the Network Key of the access point (or router).

 

12 The window showing the wireless network setting appears. Check the 
settings and click Next.

 

• Can start to build Wi-Fi Direct by using Samsung Easy Printer Manager 
(see "Setting up Wi-Fi Direct" on page 119).

• Wi-Fi Direct Name: The default Wi-Fi Direct Name is the model name 
and the maximum length is 22 characters.

• Password setting is the numeric string, and the size is 8 ~ 64 characters.

 

13 The Wireless Network Setting Complete window appears. Click Next.

14 When the wireless network settings are completed, disconnect the USB 
cable between the computer and machine. Click Next.

15 Follow the instructions in the installation window.

Access point without a USB cable

Items to prepare

• WiFi-enabled Mac running Mac OS 10.7 or higher and an access point 
(router)

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

1 Make sure that the machine is connected to your computer and

powered on.

2 Insert the supplied software CD into your CD-ROM drive.

3 Select the CD-ROM volume that appears on Finder.

4 Double-click Install Software icon.

5 Read the license agreement and check installation agreement button.

6 Click Next.
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7 Select Wireless on the Printer Connection Type screen.

8 Click Next.

9 If the installer asks you to allow access to the keychain, click Allow.

10 If the Select a wireless printer window appears, select the printer 
named DIRECT-xxx.

 

If the Press WPS button on your printer screen appears, press the  

(WPS) button from the control panel within 2 minutes.

 

11 When the wireless network set up is complete, follow the instructions in 
the installation window.
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Using a network cable

 

See your network administrator, or the person that set up your wireless 
network, for information about your network configuration.

 

Your machine is a network compatible machine. To enable your machine to 

work with your network, you will need to perform some configuration 

procedures.

Items to prepare

• Access point

• Network-connected computer

• Software CD that was provided with your machine

• A machine installed with a wireless network interface

• Network cable

Printing a network configuration report

You can identify the network settings of your machine by printing a network 

configuration report.

See "Printing a network configuration report" on page 97.

IP setting using SetIP Program (Windows)

This program is used to manually set the network IP address of your machine 

using its MAC address to communicate with the machine. The MAC address is 

the hardware serial number of the network interface and can be found in the 

Network Configuration Report. 

See "Printing a network configuration report" on page 97.
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Configuring the machine’s wireless network

Before starting you will need to know the network name (SSID) of your wireless 

network and the network key if it is encrypted. This information was set when 

the access point (or wireless router) was installed. If you do not know about your 

wireless environment, please ask the person who set up your network.

To configure wireless parameters, you can use SyncThru™ Web Service.

Using SyncThru™ Web Service

Before starting wireless parameter configuration, check the cable connection 

status. 

1 Check whether or not the network cable is connected to the machine. If 
not, connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec0000

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wi-Fi > Wizard.

7 Select the one Network Name(SSID) in the list.

8 Click Next.

If the wireless security setting window appears, enter the registered 
password (network password) and click Next.

9 The confirmation window appears, please check your wireless setup. If 
the setup is right, click Apply.
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Turning the Wi-Fi network on/off

1 Check whether the network cable is connected to the machine. If not, 
connect the machine with a standard network cable.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login on the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000

5 When the SyncThru™ Web Service window opens, click Network 
Settings.

6 Click Wi-Fi.

7 You can turn the Wi-Fi network on/off.
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Setting the Wi-Fi Direct for mobile printing

Wi-Fi Direct is a secure and easy-to-use peer-to-peer connection between a Wi-

Fi Direct-enabled printer and mobile device.

With Wi-Fi Direct, you can connect your printer to a Wi-Fi Direct network while 

concurrently connecting to an access point. You can also use a wired network 

and a Wi-Fi Direct network simultaneously so multiple users can access and print 

documents both from Wi-Fi Direct and from a wired network.

 

• You cannot connect your mobile device to the internet through the 
printer’s Wi-Fi Direct.

• The supported protocol list may differ from your model, Wi-Fi Direct 
networks do NOT support IPv6, network filtering, IPSec, WINS, and SLP 
services. 

• The maximum number of devices that can be connected via Wi-Fi Direct 
is 4.

 

Setting up Wi-Fi Direct

You can enable Wi-Fi Direct feature by one of the following methods.
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From the network-connected computer

If your printer is using a network cable or a wireless access point, you can enable 

and configure Wi-Fi Direct from SyncThru™ Web Service.

• Access SyncThru™ Web Service, select Settings > Network Settings > 
Wireless > Wi-Fi Direct.

• Enable or disable Wi-Fi Direct and set other options.

Setting up the mobile device

• After setting up Wi-Fi Direct from the printer, refer to the user manual of the 
mobile device you are using to set its Wi-Fi Direct.

• After setting up Wi-Fi Direct, you need to download the mobile printing 
application (For example: Samsung Mobile printer) to print from your 
smartphone.

 

• When you have found the printer you want to connect to from your 
mobile device, select the printer and the printer's LED will blink. Press the 
WPS button on the printer and it will be connected to your mobile 
device.

•  If your mobile device does not support Wi-Fi Direct, you need to enter 
the "Network Key" of a printer instead of pushing the WPS button.
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Troubleshooting

Problems during setup or driver installation

Printers Not Found

• Your machine may not be turned on. Turn on your computer and the 
machine.

• USB cable is not connected between your computer and machine. Connect 
the machine to your computer using the USB cable.

• The machine does not support wireless networking. Check the machine's 
user's guide included on the software CD supplied with your machine and 
prepare a wireless network machine.

Connecting Failure - SSID Not Found

• The machine is unable to find the network name (SSID) you have selected or 
entered. Check the network name (SSID) on your access point and try 
connecting again. 

• Your access point is not turned on. Turn on your access point.
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Connecting Failure - Invalid Security

• Security is not configured correctly. Check the configured security on your 
access point and machine.

Connecting Failure - General Connection Error

• Your computer is not receiving a signal from your machine. Check the USB 
cable and your machine’s power.

Connecting Failure - Connected Wired Network

• Your machine is connected with a wired network cable. Remove the wired 
network cable from your machine.

Connecting Failure - Assigning the IP address

• Cycle the power for the access point (or wireless router) and machine.

PC Connection Error

• The configured network address is unable to connect between your 
computer and machine.

- For a DHCP network environment

The receives the IP address automatically (DHCP) when computer is 
configured to DHCP.

 

If the printing job is not working in DHCP mode, the problem may be caused 
by the automatically changed IP address. Compare the IP address between 

the product's IP address and the printer port's IP address.

How to compare:
1 Print the network information report of your printer, and then check the 

IP address (see "Printing a network configuration report" on page 97).

2 Check the printer port's IP address from your computer.

a Click the Windows Start menu. 

• For Windows 8, from the Charms, select Search > Settings.

b For Windows XP Service Pack 3/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/ Windows 8, select Control Panel > Devices and 
Printers. 

c Right-click your machine.

d For Windows XP Service Pack 3/2003/2008/Vista, press Properties.

For Windows 7/ Windows 8 or Windows Server 2008 R2, from context 
menus, select the Printer properties.

If Printer properties item has ► mark, you can select other printer 
drivers connected with selected printer.

e Click Port tab.

f Click Configure Port.. button.

g Check if Printer Name or IP Address: is the IP address on the network 
configuration Sheet.

3 Change the printer port's IP address if it is different from the network 
information report's.

If you want to use the software installation CD to change the port IP, 
connect to a network printer. Then reconnect the IP address.
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- For a Static network environment

The machine uses the static address when the computer is configured 
to static address.

For example,

If the computer’s network information is as shown below:

▪ IP address: 169.254.133.42

▪ Subnet Mask: 255.255.0.0

Then the machine’s network information should be as below:

▪ IP address: 169.254.133.43

▪ Subnet Mask: 255.255.0.0 (Use the computer’s subnet mask.)

▪ Gateway: 169.254.133.1

Other problems

If problems occur while using the machine on a network, check the following: 

 

For information on the access point (or wireless router), refer to its own 
user's guide. 

 

• You cannot enable wired and wireless networks at the same time.

• Your computer, access point (or wireless router), or machine may not be 
turned on.

• Check the wireless reception around the machine. If the router is far from 
the machine or there is an obstacle, you might have difficulty receiving the 
signal. 

• Cycle the power for the access point (or wireless router), machine, and 
computer. Sometimes cycling the power can recover network 
communication.

• Check whether firewall software (V3 or Norton) is blocking the 
communication. 

If the computer and the machine are connected on the same network and it 
cannot be found when searching, firewall software might be blocking the 
communication. Refer to the user's guide for the software to turn it off and 
try searching for the machine again.

• Check whether the machine's IP address is allocated correctly. You can 
check the IP address by printing the network configuration report.

• Check whether the access point (or wireless router) has a configured 
security (password). If it has a password, refer to the access point (or wireless 
router) administrator.

• Check the machine's IP address. Reinstall the machine driver and change the 
settings to connect to the machine on the network. Due to the 
characteristics of DHCP, the allocated IP address could change if the 
machine is not used for a long time or if the access point has been reset.

Register the product's MAC address when you confogure the DHCP server 
on the access point (or wireless router). Then you can always use the IP 
address that is set with the MAC address. You can identify the Mac address 
of your machine by printing a network configuration report (see "Printing a 
network configuration report" on page 97).
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• Check the wireless environment. You might not be able to connect to the 

network in the infrastructure environment where you need to type in a 
user's information before connecting to the access point (or wireless router).

• This machine only supports IEEE 802.11 b/g/n and Wi-Fi. Other wireless 
communication types (e.g., Bluetooth) are not supported.

• You cannot use infrastructure mode at the same time for Samsung wireless 
network machines.

• The machine is within the range of the wireless network.

• The machine is located away from obstacles that could block the wireless 
signal.

Remove any large metal objects between the access point (or wireless 
router) and the machine.

Make sure the machine and wireless access point (or wireless router) are not 
separated by poles, walls, or support columns containing metal or concrete.

• The machine is located away from other electronic devices that may 
interfere with the wireless signal.

Many devices can interfere with the wireless signal, including a microwave 
oven and some Bluetooth devices.

• Whenever the configuration of your access point (or wireless router) 
changes, you must do the product's wireless network setup again.

• The maximum number of device that can be connected via Wi-Fi Direct is 3.

• If Wi-Fi Direct is ON, this machine only supports IEEE 802.11 b/g.

• If the access point is set to work with the 802.11n standard only, it may not 
connect to your machine.
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What is Samsung Mobile Print?

Samsung Mobile Print is a free application that enables users to print photos, 

documents, and web pages directly from your smartphone or tablet. Samsung 
Mobile Print is not only compatible with your Android and iOS smart phones 

but also with your iPod Touch and tablet PC. It connects your mobile device to a 

network connected Samsung printer or to a wireless printer through a Wi-Fi 

access point. Installing a new driver or configuring network settings isn’t 

necessary – just simply install the Samsung Mobile Print application, and it will 

automatically detect compatible Samsung printers. Besides printing photos, 

web pages, and PDFs, scanning is also supported. If you have a Samsung 

multifunction printer, scan any document into a JPG, PDF, or PNG format for 

quick and easy viewing on your mobile device. 
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Downloading Samsung Mobile Print

To download Samsung Mobile Print, go to the application store (Samsung 

Apps, Play Store, App Store) on your mobile device, and just search for 

“Samsung Mobile Print.” You can also visit iTunes for Apple devices on your 

computer.
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Supported Mobile OS 

• Android OS 2.3 or higher 

• iOS 4.0 or higher
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The NFC(Near Field Communication) printer allows you to directly print from 

your cell phone just by holding your cell phone over the NFC tag on your printer. 

It does not require installing print driver or connecting to an access point. You 

just need NFC supported cell phone. In order to use this feature, Samsung 

Mobile Print app needs to be installed on your cell phone. 

 

• Depending on the material of the cell phone cover, NFC recognition may 
not work properly.

• Depending on the cell phone you are using, the tranmission speed may 
differ.
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Requirements

• NFC and Wi-Fi Direct enabled, Mobile Print app installed cell phone with 
Android OS 4.0 or higher.

 

Only Android OS 4.1 or higher will automatically enable the Wi-Fi Direct 
feature on your cell phone when you enable the NFC feature. We 
recommend you to upgrade your cell phone to Android OS 4.1 or higher to 
use the NFC feature.

 

• Wi-Fi Direct feature enabled printer. Wi-Fi Direct feature is enabled by 
default.
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Printing

1 Check that NFC and Wi-Fi Direct feature are enabled on your cell phone 

and Wi-Fi Direct feature is enabled on your printer (see "Setting up Wi-Fi 
Direct" on page 119). 

2 Tag the NFC antenna on your cell phone (usually located on the back of 
the cell phone) over the NFC tag( ) on your printer.

Wait few seconds for the Samsung Mobile Print app to start.

 

• For some cell phones, NFC antenna might not be located at the back of 
the cell phone. Check the location of the NFC antenna on your cell phone 
before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

• If you do not have Samsung Mobile Print app installed on your cell 
phone, it automatically connects to Samsung Mobile Print app 
download page. Download the app and try again. 
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3 Select the content you want to print.

If neccessary, change the print option by pressing the .

4 Tag the NFC antenna on your cell phone(usually located on the back of 
the cell phone) over the NFC tag( ) on your printer.

Wait few seconds for the cell phone to connect to the printer.

 

• For some cell phones, NFC antenna might not be located at the back of 
the cell phone. Check the location of the NFC antenna on your cell phone 
before tagging.

• If error message about changed PIN number appears, enter a changed 
PIN number and press OK. Follow the instruction on the app screen to 
update the PIN number. 

 

5 The printer starts printing.
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Only Mopria-certified machines can use the Mopria feature. Check the box 
that your machine came in for the Mopria-certified logo.
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Setting up the machine for Mopria printing

Bonjour(mDNS) and IPP protocols are required on your machine to use the 

Mopria feature. Perform the following steps to enable the Mopria feature. 

1 Ensure that the machine is connected to the network.

2 On your computer, open a web browser (Internet Explorer, Safari, or 
Firefox) and type the IP address of the machine in the address bar. Then, 
press Enter.

For example,

3 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Standard TCP/IP, LPR, IPP > IPP. Then, select 
Enable.

6 Click Settings > Network Settings > mDNS. Then, select Enable.

7 Click Security > System Security > Feature Management > Mopria. 
Then, select Enable.
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Setting up Mopria on your mobile device

If you do not have Mopria Print Service app installed on your mobile device, 

open to the app store (Play Store, App Store) on your mobile device, search 

for,Mopria Print Service, and then download and install the app.

Mopria™ Print Service is a mobile printing solution that enhances 
the new print functionality on any Android phone or tablet 
(Android version 4.4 or later). With this service, you can connect 
and print to any Mopria-certified printer on the same network as 
your mobile device without additional set-up. Many native 
Android apps support printing, including Chrome, Gmail, Gallery, 
Drive and Quickoffice.
1272.  Using a Network-Connected Machine



Mopria™

1 In the Settings menu of your Android device, tap Printing.

 

The location of this option may differ depending on your mobile device. If 
you cannot locate the Printing option, refer to the user's manual for your 
mobile device.

 

2  Under Print Services, tap Mopria Print Service.

3 Tap the On/Off slider to enable the Mopria Print Service. 
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Printing via Mopria

To print via Mopria on an Android device:

1 Open the email, photo, web page, or document that you want to print.

2 Tap Print on the menu in the app.

3 Select your printer, and then configure the print options.

4 Touch Print again to print the document.

 

To cancel a print job: Select and delete the document from the print queue 
in the Notification Bar.
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Only AirPrint certified machines can use the AirPrint feature. Check the box 
your machine came in for the AirPrint certified mark.
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Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the 

AirPrint feature. You can enable the AirPrint feature by one of the following 

methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the SyncThru™ Web Service website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

5 When the Embedded Web Service window opens, click Settings > 
Network Settings.

6 Click Raw TCP/IP, LPR, IPP or mDNS.

You can enable the IPP protocol or mDNS protocol.
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Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.

AirPrint allows you to wirelessly print directly from iPhone, iPad and 
iPod touch running the latest version of iOS.
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Cancelling print job: To cancel the printing job or view the print summary, 

click the print center icon ( ) in multitasking area. You can click cancel in 

the print center.
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3. Special Features
This chapter explains special printing features.
• Altitude adjustment 132
• Printing features 133
 

The procedures in this chapter are mainly based on Windows 7.

 



Altitude adjustment

Print quality is affected by atmospheric pressure, which is determined by the 

height of the machine above sea level. The following information will guide you 

on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

• Normal: 0-1,000 m(3,280 ft)

• High1: 1,000 m(3,280 ft)-2,000 m(6,561 ft)

• High2: 2,000 m(6,561 ft)-3,000m(9,842 ft) 

• High3: 3,000 m(9,842 ft)-4,000 m(13,123 ft)

• High4: 4,000 m(13,123 ft)-5,000 m(16,404 ft)

• For Windows and Mac users, you set from Samsung Easy Printer Manager 
> Advanced Setting > Device Settings. See "Using Samsung Easy Printer 
Manager" on page 156.

 

If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 153).
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• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 35).

• This feature may not be available depending on model or optional goods 
(see "Features by model" on page 6).
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Changing the default print settings

1 Click the Windows Start menu. 

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 

3 Right-click on your machine.

4 For Windows XP/Server 2003/Server 2008/Vista, select Printing 
Preferences.

For Windows 7/8 or Windows Server 2008 R2, from context menus, select 
Printing preferences.

 

If Printing preferences has a ►, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab. 

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences. 
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Setting your machine as a default machine

1 Click the Windows Start menu.

• For Windows 8, from the Charms, select Search > Settings.

2 For Windows XP/Server 2003, select Printer and Faxes. 

• For Windows Server 2008/Vista, select Control Panel > Hardware 
and Sound > Printers. 

• For Windows Server 2008 R2, select Control Panel > Hardware > 
Devices and Printers. 

• For Windows 7/8, select Control Panel > Devices and Printers. 
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3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

For Windows 7 or Windows Server 2008 R2, if Set as default printer has a 
►, you can select other printer drivers connected to the selected printer.
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Using advanced print features

 

XPS printer driver: used to print XPS file format. 

• See "Features by model" on page 6.

• The XPS printer driver can be installed only on Windows Vista OS or 
higher.

• For models that provide XPS driver from the Samsung website, http://
www.samsung.com  > find your product> Support or downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file. 

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 

settings. The machine name that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or click the  button from the window or press F1 on your keyboard and click on any option you want to know about (see "Using help" 
on page 38).

 

 

Item Description

Multiple Pages per 
Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet. 
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Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.

Booklet Printing

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 

a booklet. 

 

• This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver.

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

Item Description
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Double-sided 
Printing (Manual)

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented. 

 

• This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver.

• If your machine does not have a duplex unit, you should complete the printing job manually. The machine prints every other page of 
the document first. After that, a message appears on your computer.

• Skip Blank Pages feature does not work when you select the duplex option.

 

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Item Description
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Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document. 

Watermark

(Creating a 
watermark)

a To change the print settings from your software application, access Printing Preferences (see "Opening Printing Preferences" on page 36).

b From the Advanced tab, select Edit... from the Watermark drop-down list. 

c Enter a text message in the Watermark Message box. You can enter up to 256 characters. 

When the First Page Only box is checked, the watermark prints on the first page only.

d Select watermark options. 

You can select the font name, style, size, and shade from the Font Attributes section, as well as set the angle of the watermark from the 
Watermark Alignment and Angle section. 

e Click Add to add a new watermark to the Current Watermarks list.   

f When you finish editing, click OK or Print until you exit the Print window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences (see "Opening Printing Preferences" on page 36).

b Click the Advanced tab, select Edit... from the Watermark drop-down list.

c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options. 

d Click Update to save the changes.

e Click OK or Print until you exit the Print window. 

Watermark

(Deleting a 
watermark)

a To change the print settings from your software application, access Printing Preferences.

b Click the Advanced tab, select Edit... from the Watermark drop-down list.

c Select the watermark you want to delete from the Current Watermarks list and click Delete. 

d Click OK or Print until you exit the Print window.

Item Description
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Overlaya

This option is available only when you use the PCL/SPL printer driver. This option is not available when you use XPS driver

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Overlaya

(Creating a new page 
overlay)

a Create or open a document containing text or an image for use in a new page overlay. Position the items exactly as you wish them to appear 
when printed as an overlay.

b To save the document as an overlay, access Printing Preferences.

c Click the Advanced tab, and select Create from the Overlay drop-down list.

d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 
C:\Formover).

e Click Save.

f Click OK or Print until you exit the Print window.

When a confirming message window appears, click Yes.

g The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
1393.  Special Features



Printing features
 

Overlaya

(Using a page overlay)

a Create or open the document you want to print.

b To change the print settings from your software application, access Printing Preferences.

c Click the Advanced tab. 

d Select the Print Overlay from the Overlay drop-down list. 

e If the overlay file you want does not appear in the Overlay File 1 or Overlay File 2 drop-down list, select Load from the Overlay List. Select 
the overlay file you want to use. 

If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Load window. 

After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box. 

f If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm your wish to print an overlay on your document. 

If this box is not checked and an overlay has been selected, the overlay automatically prints with your document. 

g Click OK or Print until you exit the Print window. 

The selected overlay prints on your document. 

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab. 

b Select Edit in the Text drop down list. 

c Select the overlay you want to delete from the Overlay List box. 

d Click Delete. 

e When a confirming message window appears, click Yes.

f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

a. This option is not available when you use XPS driver.

Item Description
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4 

Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 

application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print. 

5 Choose the number of copies and indicate which pages to print. 

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 

which appears in the printer properties window, may differ depending on the 

machine in use. Except for the name, the composition of the printer properties 

window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 

provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print. 

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 8).

 

Before printing in the duplex mode, decide on which edge you will be binding 

your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. 

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 

the topic you want to know about. A pop-up window appears with information 

about that option's feature, which is provided from the driver. 
1423.  Special Features



Printing features

5 

Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 

Printing System (CUPS). You can print on your machine from any such 

application.

1 Open the document to print.

2 Open the File menu and click Page Setup (Print Setup for some

applications).

3  Choose your paper size, orientation, and make

sure that your machine is selected. Click Apply.

4  Open the File menu and click Print.

5  Select your machine to print.

6 Choose the number of copies and indicate which pages to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic/manual duplex printing may not be available depending on 
models. You can alternatively use the lpr printing system or other 
applications for odd-even printing (see "Features by model" on page 6).

 

Printing files

You can print text, image, pdf files on your machine using the standard

CUPS directly from the command line interface. The CUPS lp or lpr utility allows 

you to do that. You can print these files by using below command format.

"lp -d <printer name> -o <option> <file name>"

Please refer to lp or lpr man page on your system for more details.
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Configuring Printer Properties

You can change the default printing options or connection type with Printing 

utility supplied by o/s.

1 Launch Printing utility(Go to System > Administration > Printing 
menu or execute "system-config-printer" command in Terminal 
program).

2 Select your printer and double-click it.

3 Change default printing options or connection type.

4 Click Apply button.
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4. Useful Management 
Tools

This chapter introduces management tools provided to help you make full use of your machine. 
• Accessing management tools 146
• Easy Capture Manager 147
• Samsung Easy Color Manager 148
• Easy Eco Driver 149
• Using Samsung Printer Center 150
• Using SyncThru™ Web Service 153
• Using Samsung Easy Printer Manager 156 
• Using Samsung Printer Status 158
• Using Samsung Printer Experience 160



Accessing management tools

Samsung provides a variety of management tools for Samsung printers. 

1 Make sure that the machine is connected to your computer and powered on.

2 From the Start menu, select Programs or All Programs.

• For Windows 8, from the Charms, select Search > Apps.

3 Find Samsung Printers.

4 Under Samsung Printers, you can see installed management tools.

5 Click the management tool you want to use.

 

• After installing the driver, for some management tools, you can access them directly from the Start menu > Programs or All Programs.

• For Windows 8, after installing the driver, for some management tools, you can access them directly from the Start screen by clicking on the corresponding tile.
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Easy Capture Manager

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows OS users only (see "Software" on page 7).

 

Capture your screen and launch Easy Capture Manager by simply pressing the Print Screen key on the keyboard. Now you can easily print your captured screen as 

captured or edited.
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Samsung Easy Color Manager

Samsung Easy Color Manager helps users do fine adjustments with 6 color tones and other properties, such as brightness, contrast, and saturation. Color tone 

changes can be saved as a profile and can be used from the driver or from inside of the machine.

 

• This feature may not be available depending on model or optional goods (see "Software" on page 7).

• Available for Windows and Mac OS users only (see "Software" on page 7).

 

Helps Samsung color laser printer users to adjust color as they like.

Download the software from the Samsung website then unpack and install it: (http://www.samsung.com > find your product > Support or Downloads).
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Easy Eco Driver

 

• Available for Windows OS users only (see "Software" on page 7).

• To use the Easy Eco Driver features, the Eco Driver Pack must be installed.

 

With the Easy Eco Driver, you can apply Eco features to save paper and toner before printing. 

Easy Eco Driver also allows you simple editing such as removing images and texts, and more. You can save frequently used settings as a favorite.

How to use: 

1 Open a document to print.

2 Open printing preference window (see "Opening Printing Preferences" on page 36).

3 From the Favorites tab, select Eco Printing Preview.

4 Click OK > Print in the window. A preview window appears.

5 Select the options you want to apply to the document.

You can see the preview of the applied features.

6 Click Print.

 

• If you want to run Easy Eco Driver every time you print, check Start Easy Eco Driver before printing job checkbox in the Basic tab of the printing preference 
window.

• To use this feature on Stylish User Interface, click Samsung Printer Center > Device Options and then select Stylish User Interface (see "Using Samsung Printer 
Center" on page 150).
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Using Samsung Printer Center

 

• Available for Windows users only.

 

The Samsung Printer Center allows you to manage all the printer drivers 

installed on your computer from a single integrated application. You can use the 

Samsung Printer Center to add and remove printer drivers, check the status of 

printers, update printer software, and configure printer driver settings.

1 

Understanding Samsung Printer Center

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Printer Center.

Printers tab

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list Displays the printer drivers installed on your computer. To add a 

printer driver to the list, click the  button.
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Scanner & Fax Tab

 

• The screenshot may differ depending on operating system you are using.

• Available for multifunction products only.

 

2

Quick links Displays links to various printer driver management functions. 
The quick links in the Printers tab link to the following functions:

• Settings: Allows you to configure the settings for individual 

printer driver.

- Set as default printer: Sets the selected printer driver as 
the default printer. If the selected printer driver is already 
set as the default printer, then this option is not activated.

- Printing preferences: Allows you to configure the default 
print settings.

- Device options: Allows you to configure advanced 
options, such as the settings for optional devices and 
additional features.

 

The option allows you to modify the Printer Status 
and Stylish User Interface settings.

 

- Change device: Allows you to change the device into 
another device.

- Properties: Allows you to configure the printer driver 
properties, such as the name of the printer driver and its 
location, or add comments about the printer driver .

• Actions: Allows you to use the scan feature (this option is 
enabled only if the selected device supports the scan feature).

• Management: Allows you to manage the devices registered 
in the program.
- Add a new printer / Remove printer: Adds a new device 

or removes an existing device.
- Diagnose printer: Diagnoses problems in the selected 

device and suggests solutions.

- Update software: Downloads and applies the applicable 
software updates.

3
Printer 
information

Provides general information about the selected device, such as 
its model, IP address, port number, and status.

1

Printer list Displays the fax and scanner driver installed on your 
computer. To add a fax or scanner driver to the list, click the 

(Add Fax) or (Add Scanner) button.

1 2

3
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2

Quick links Displays links to the functions available for managing fax or 
scanner drivers. The quick links in the Scanner & Fax tab offer 
the following features:

 

To use this feature, the scanner driver and fax driver 
must be installed on the computer.

 

• Settings: Allows you to configure the settings for fax or 
scanner dirvers.

- Address Book (fax only): Opens the Address Book.

- Fax Transmission History (fax only): Opens the fax 
transmission history.

- Fax preferences (fax only): Allows you to configure the 
default fax settings.

- Change device: Allows you to change the devices into 
another device.

- Properties: Allows you to configure the properties of a 
device, such as location and add comments about the 
device.

• Actions: Allows you to use the scan feature.

• Management: Allows you to manage the devices 
registered in the program.

- Remove fax or Remove scan: Removes the selected fax 
or scan driver.

- Update software: Downloads and applies the 
applicable software updates.

3
Printer 
information

Provides general information about the selected device, such 
as the model, IP address, port number, and machine status.
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Using SyncThru™ Web Service

 

• Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

• SyncThru™ Web Service explanation in this user’s guide may differ from 
your machine depending on its options or models.

• Network model only.

 

2 

Accessing SyncThru™ Web Service

1 Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address of your printer (http://xxx.xxx.xxx.xxx) in 
the address field and press the Enter key or click Go.

2 Your machine’s embedded website opens.

Logging into SyncThru™ Web Service

Before configuring options in SyncThru™ Web Service, you need to log-in as an 

administrator. You can still use SyncThru™ Web Service without logging in but 

you won’t have access to Settings tab and Security tab. 

1 Click Login on the upper right of the SyncThru™ Web Service website.

2 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and password. 
We recommend you to change the default password for security 
reasons.

• ID: admin 

• Password: sec00000

3 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.
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Information tab

This tab gives you general information about your machine. You can check 

things, such as remaining amount of toner. You can also print reports, such as an 

error report.

• Active Alerts: Shows the alerts that have occurred in the machine and their 
severity.

• Supplies: Shows how many pages are printed and amount of toner left in 
the cartridge.

• Usage Counters: Shows the usage count by print types: simplex and 
duplex.

• Current Settings: Shows the machine’s and network’s information. 

• Print information: Prints reports such as system related reports and font 
reports.

Settings tab

This tab allows you to set configurations provided by your machine and 

network. You need to log-in as an administrator to view this tab. 

• Machine Settings tab: Sets options provided by your machine. 

• Network Settings tab: Shows options for the network environment. Sets 
options such as TCP/IP and network protocols. 

Security tab

This tab allows you to set system and network security information. You need to 

log-in as an administrator to view this tab.

• System Security: Sets the system administrator’s information and also 
enables or disables machine features.

• Network Security: Sets settings for IPv4/IPv6 filtering.

Maintenance tab

This tab allows you to maintain your machine by upgrading firmware and 

setting contact information for sending emails. You can also connect to 

Samsung website or download drivers by selecting the Link menu.

• Firmware Upgrade: Upgrade your machine’s firmware.

• Contact Information: Shows the contact information.

• Link: Shows links to useful sites where you can download or check 
information.

4 

Setting the system administrator’s information

This setting is necessary for using the e-mail notification option.
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1 Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address field 
and press the Enter key or click Go.

2 Your machine’s embedded website opens.

3 From the Security tab, select System Security > System Administrator

4 Enter the name of the administrator, phone number, location, and email 
address. 

5 Click Apply. 
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Using Samsung Easy Printer Manager 

 

• Available for Windows and Mac OS users only.

• For Windows, Internet Explorer 6.0 or higher is the minimum 
requirement for Samsung Easy Printer Manager.

 

Samsung Easy Printer Manager is an application that combines Samsung 

machine settings into one location. Samsung Easy Printer Manager combines 

device settings as well as printing environments, settings/actions and 

launching. All of these features provide a gateway to conveniently use your 

Samsung machine. Samsung Easy Printer Manager provides two different user 

interfaces for the user to choose from: the basic user interface and the advanced 

user interface. Switching between the two interfaces is easy: just click a button.

5 

Understanding Samsung Easy Printer Manager

To open the program: 

For Windows,

Select Start > Programs or All Programs > Samsung Printers > Samsung 
Easy Printer Manager .

For Mac,

Open the Applications folder > Samsung folder > Samsung Easy Printer 
Manager.

The Samsung Easy Printer Manager interface is comprised of various basic 

sections as described in the table that follows:

 

The screenshot may differ depending on operating system you are using.

 

1
Printer list The Printer list displays printers installed on your computer 

and network printers added by network discovery (Windows 
only).

1

5

6

4

32

7
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Select the Help menu or click the  button from the window and click on 

any option you want to know about.

 

2 Advanced 
Setting

The advanced user interface is intended to be used by the person 
responsible for managing the network and machines.

 

Some menus may not appear in the display depending 
on options or models. If so, it is not applicable to your 
machine.

 

• Device Settings: You can configure various machine settings 
such as machine setup, paper, layout, emulation, network, and 
print information. 

 

If you connect your machine to a network, the SyncThru™ 
Web Service icon is enabled.

 

• Alert Settings (Windows only): This menu includes settings 
related to error alerting. 

- Printer Alert: Provides settings related to when alerts will 
be received.

- Email Alert: Provides options relating to receiving alerts 
via email.

- Alert History:  Provides a history of device and toner 
related alerts.

3
Application 
information

Includes links for changing to the refresh, preference setting, 
help, and about.

4

Printer 
information

This area gives you general information about your machine. You 
can check information, such as the machine’s model name, IP 
address (or Port name), and machine status.

 

This button opens the Troubleshooting Guide when 
an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

5

Quick links Displays Quick links to machine specific functions. This 
section also includes links to applications in the advanced 
settings.

 

If you connect your machine to a network, the SyncThru™ 
Web Service icon is enabled.

 

6
Contents 
area

Displays information about the selected machine, remaining 
toner level, and paper. The information will vary based on the 
machine selected. Some machines do not have this feature.

7
Order 
supplies

Click on the Order button from the supply ordering window. 
You can order replacement toner cartridge(s) from online.
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The Samsung Printer Status is a program that monitors and informs you of the 

machine status. 

 

• The Samsung Printer Status window and its contents shown in this user’s 
guide may differ depending on the machine or operating system in use.

• Check the operating system(s) that are compatible with your machine 
(see "System requirements" on page 73).

• Available for Windows OS users only.

 

6 

Samsung Printer Status overview

If an error occurs while operating, you can check the error from the Samsung 

Printer Status. Samsung Printer Status is installed automatically when you install 

the machine software. 

You can also launch Samsung Printer Status manually. Go to the Printing 
Preferences, click the Basic tab > Printer Status button.

These icons appear on the Windows task bar:

Icon Mean Description

Normal The machine is in ready mode and experiencing no 
errors or warnings.

Warning The machine is in a state where an error might 
occur in the future. For example, it might be in 
toner low status, which may lead to toner empty 
status.

Error The machine has at least one error.

1

3

2

7

4 5 6
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1

Device 
Information

You can see the device status , current printer model 
name, connected port name in this area.

2

User’s Guide You can view the online User’s Guide.

 

This button opens the Troubleshooting Guide 
when an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

3

Supplies 
Information

You can view the percentage of toner remaining in 
each toner cartridge. The machine and the number of 
toner cartridge(s) shown in the above window may 
differ depending on the machine in use. Some 
machines do not have this feature.

4

Option
You can set printing job alert related settings. 

5

Order Supplies You can order replacement toner cartridge(s) from 
online.

6

Cancel Print 

or 

Close

• Cancel Print : If print job is waiting in the print 
queue or printer, cancel all user's print jobs in the 
print queue or the printer.

• Close : Depending on the status of the machine or 
the supported functions, the Close  button may 
appear to close the status window.

7 Toner/Paper 
Information

This button areas for paper and toner info will be 
available based on the device.
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Using Samsung Printer Experience 

Samsung Printer Experience is a Samsung application that combines 

Samsung machine settings and machine management into one location. You 

can set device settings, order supplies, open troubleshooting guides, visit 

Samsung’s web site, and check connected machine information. This 

application will be automatically downloaded from the Windows Store if the 

machine is connected to a computer with an Internet connection. 

7 

Understanding the Samsung Printer Experience

To open the application, 

From the Start screen, select the Samsung Printer Experience ( ) tile. 

The Samsung Printer Experience interface comprises various useful features as 

described in the following table:

 

The screenshot may differ depending on the model you are using.

 

1

Printer 
Information

This area gives you general information about your 
machine. You can check information, such as the 
machine’s status, location, IP address, and remaining 
toner level.

1
2 6

3

4

5
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8 

Adding/Deleting Printers

If you do not have any printer added to the Samsung Printer Experience, or if 

you want to add/delete a printer, follow the instructions below. 

 

You can only add/delete network connected printers.

 

Adding a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Add Printer

3 Select the printer you want to add.

You can see the added printer.

 

If you see  mark, you can also click  mark to add printers.

 

2 User’s Guide You can view the online User’s Guide. You need to be 
connected to the Internet to use this feature.

 

This button opens the Troubleshooting Guide 
when an error occurs. You can directly open the 
troubleshooting section in the user’s guide. 

 

3
Order Supplies Click on this button to order replacement toner 

cartridges online. You need to be connected to the 
Internet to use this feature. 

4
Visit Samsung Links to Samsung printer website. You need to be 

connected to the Internet to use this feature.

5

Printer Settings You can configure various machine settings such as 
machine setup, paper, layout, emulation, networking, 
and print information through SyncThru™ Web Service. 
Your machine needs to be connected to a network. This 
button will be disabled if your machine is connected via 
USB cable.

6

Device List & 
Latest Scanned 
Image

The scan list displays devices that supports Samsung 
Printer Experience. Under the device, you can see the 
latest scanned images. Your machine needs to be 
connected to a network to scan from here. 

This section is for the users with multi-functional printers.
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Deleting a printer

1 From the Charms, select Settings.

Or, right-click the Samsung Printer Experience page and select 
Settings.

2 Select Remove Printer

3 Select the printer you want to delete.

4 Click Yes.

You can see that the deleted printer is removed from the screen.

9 

Printing from Windows 8

This section explains common printing tasks from the Start screen.

Basic printing

1 Open the document to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Select the printer settings, such as the number of copies and orientation.

5 Click the Print button to start the print job.

Cancelling a print job

If the printing job is waiting in the print queue or print spooler, cancel the job as 

follows:

• You can access this window by simply double-clicking the machine icon 

( ) in the Windows task bar. 

• You can also cancel the current job by pressing (Cancel or Stop/Clear) 

button on the control panel.
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Opening more settings

 

The screen may appear somewhat different depending on the model or 
options.

 

You can set up more printing parameters.

1 Open the document you want to print.

2 From the Charms, select Devices.

3 Select your printer from the list

4 Click More settings.

Basic tab

Basic

This option allows you to choose the basic printing settings such as copies, 

orientation, and document type.

Eco settings

This option allows you to choose multiple pages per side to save media.
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Advanced tab

Paper settings

This option allows you to set the basic paper handling specifications.

Layout settings

This option allows you to set the various ways to layout your documents.

Security tab
 

Some features may not be available depending on the model or options. If 
this tab is not shown or disabled, it means that these features are not 
supported.

 

Job Accounting

This option allows you to print with the given permission.

Confidential Printing

This option is used for printing confidential documents. You need to enter a 

password to print using it.
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Using the sharing feature

 Samsung Printer Experience allows you to print from other applications 

installed on the computer using the sharing feature. 

 

 This feature is only available for printing jpeg, bmp, tiff, gif, and png file 
formats.

 

1 Select the content you want to print from other application.

2 From the Charms, select Share > Samsung Printer Experience .

3 Select the printer settings, such as the number of copies and orientation.

4 Click the Print button to start the print job.
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5. Troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
• Paper feeding problems 167
• Power and cable connecting problems 168
• Printing problems 169
• Printing quality problems 173
• Operating system problems 181



Paper feeding problems
Condition Suggested solutions

Paper jams during printing. Clear the paper jam.

Paper sticks together. • Check the maximum paper capacity of the tray.

• Make sure that you are using the correct type of paper.

• Remove paper from the tray and flex or fan the paper.

• Humid conditions may cause some paper to stick together.

Multiple sheets of paper do not feed. Different types of paper may be stacked in the tray. Load paper of only one type, size, and weight.

Paper does not feed into the machine. • Remove any obstructions from inside the machine.

• Paper has not been loaded correctly. Remove paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove excess paper from the tray.

• The paper is too thick. Use only paper that meets the specifications required by the machine.

The paper keeps jamming. • There is too much paper in the tray. Remove excess paper from the tray. If you are printing on special materials, feed 
manually in the tray.

• An incorrect type of paper is being used. Use only paper that meets the specifications required by the machine.

• There may be debris inside the machine. Open the top cover and remove any debris.
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Power and cable connecting problems

Reboot the power. If the problem persists, please call for service.

Condition Suggested solutions

The machine is not receiving power, 

or the connection cable between the 
computer and the machine is not 
connected properly.

1 Connect the machine to the electricity supply first. 

2 Check the USB cable or network cable in the machine’s rear.

3 Disconnect the USB cable or network cable in the machine’s rear and then, reconnect it.

1

2

1685.  Troubleshooting



Printing problems
Condition Possible cause Suggested solutions

The machine does not 
print.

The machine is not receiving power. Check the power cord connections. Check the power switch and the power source.

The machine is not selected as the default 
machine.

Select your machine as your default machine in Windows.

Check the machine for the following:

• The top cover is not closed. Close the top cover.

• Paper is jammed. Clear the paper jam (see "Clearing paper jams" on page 60).

• No paper is loaded. Load paper (see"Loading paper in the tray" on page 28).

• The toner cartridge is not installed. Install the toner cartridge (see "Replacing the toner cartridge" on page 49).

• Make sure the protect cover and sheets are removed from the toner cartridge (see "Replacing the toner cartridge" on page 49).

If a system error occurs, contact your service representative.

The connection cable between the computer and 
the machine is not connected properly.

Disconnect the machine cable and reconnect it (see "Rear view" on page 19).

The connection cable between the computer and 
the machine is defective.

If possible, attach the cable to another computer that is working properly and print a job. 
You can also try using a different machine cable.

The port setting is incorrect. Check the Windows printer settings to make sure that the print job is sent to the correct 
port. If the computer has more than one port, make sure that the machine is attached to 
the correct one.

The machine may be configured incorrectly. Check the Printing Preferences to ensure that all of the print settings are correct.
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Printing problems
The machine does not 
print.

The printer driver may be incorrectly installed. Uninstall and reinstall the machine’s driver.

The machine is malfunctioning. Check the display message on the control panel to see if the machine is indicating a 
system error. Contact a service representative.

The document size is so big that the hard disk 
space of the computer is insufficient to access the 
print job.

Get more hard disk space and print the document again.

The output tray is full. Once the paper is removed from the output tray, the machine resumes printing.

The machine selects print 
materials from the wrong 
paper source.

The paper option that was selected in the 
Printing Preferences may be incorrect.

For many software applications, the paper source selection is found under the Paper tab 
within the Printing Preferences (see "Opening Printing Preferences" on page 36). 
Select the correct paper source. See the printer driver help screen (see "Using help" on 
page 38).

A print job is extremely 
slow.

The job may be very complex. Reduce the complexity of the page or try adjusting the print quality settings.

Half the page is blank. The page orientation setting may be incorrect. Change the page orientation in your application (see "Opening Printing Preferences" on 
page 36). See the printer driver help screen (see "Using help" on page 38).

The paper size and the paper size settings do not 
match.

Ensure that the paper size in the printer driver settings matches the paper in the tray.

Or, ensure that the paper size in the printer driver settings matches the paper selection 
in the software application settings you use (see "Opening Printing Preferences" on 
page 36).

Condition Possible cause Suggested solutions
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Printing problems
The machine prints, but 
the text is wrong, 
garbled, or incomplete.

The machine cable is loose or defective. Disconnect the machine cable and reconnect. Try a print job that you have already 
printed successfully. If possible, attach the cable and the machine to another computer 
that you know works and try a print job. Finally, try a new machine cable.

The wrong printer driver was selected. Check the application's printer selection menu to ensure that your machine is selected.

The software application is malfunctioning. Try printing a job from another application.

The operating system is malfunctioning. Exit Windows and reboot the computer. Turn the machine off and back on again.

Pages print, but they are 
blank.

The toner cartridge is defective or out of toner. Redistribute the toner, if necessary. 

If necessary, replace the toner cartridge.

• See "Redistributing toner" on page 47.

• See "Replacing the toner cartridge" on page 49.

The file may have blank pages. Check the file to ensure that it does not contain blank pages.

Some parts, such as the controller or the board, 
may be defective.

Contact a service representative.

The machine does not 
print PDF files correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and the 
Acrobat products.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image 
from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

The print quality of 
photos is not good. 
Images are not clear.

The resolution of the photo is very low. Reduce the photo size. If you increase the photo size in the software application, the 
resolution will be reduced. 

Condition Possible cause Suggested solutions
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Printing problems
Before printing, the 
machine emits vapor near 
the output tray.

Using damp/wet paper can cause vapor [white 
smoke] during printing.

This is not a problem, just keep printing.  If you are bothered by the smoke [vapor], then 
replace the paper with fresh paper from an unopened ream.

The machine does not 
print special-sized paper, 
such as billing paper.

Paper size and paper size setting do not match. Set the correct paper size in the Custom in Paper tab in Printing Preferences (see 
"Opening Printing Preferences" on page 36).

The printed billing paper 
is curled.

The paper type setting does not match. Change the printer option and try again. Go to Printing Preferences, click Paper tab, 
and set type to Thick (see "Opening Printing Preferences" on page 36).

Condition Possible cause Suggested solutions
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Printing quality problems

If the inside of the machine is dirty or paper has been loaded improperly, there might be a reduction in print quality. See the table below to clear the problem. 

 

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area appears on the page, the toner supply is low. Install a new toner cartridge (see "Replacing the 
toner cartridge" on page 49).

• If a vertical white streak or faded area still appears on the page even though the machine has enough toner supply, open and close 
the front door 3 ~ 4 times (see "Machine overview" on page 17).

• The paper may not meet paper specifications; for example, the paper may be too moist or rough.

• If the entire page is light, the print resolution setting is too low or the toner save mode is on. Adjust the print resolution and turn 
the toner save mode off. See the help screen of the printer driver.

• A combination of faded or smeared defects may indicate that the toner cartridge needs cleaning. Clean the inside of your machine 
(see "Cleaning the machine" on page 55).

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
55). If these steps do not correct the problem, contact a service representative.

The top half of the paper is 
printed lighter than the rest of 
the paper

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening Printing Preferences" on page 36).
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Printing quality problems
Toner specks • The paper may not meet specifications; for example, the paper may be too moist or rough.

• The transfer roller may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 55).

• The paper path may need cleaning. Contact a service representative (see "Cleaning the machine" on page 55).

Dropouts If faded areas, generally rounded, occur randomly on the page:

• A single sheet of paper may be defective. Try reprinting the job.

• The moisture content of the paper is uneven or the paper has moist spots on its surface. Try a different brand of paper.

• The paper lot is bad. The manufacturing processes can cause some areas to reject toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thick or Thicker (see 
"Opening Printing Preferences" on page 36).

If these steps do not correct the problem, contact a service representative.

White Spots If white spots appear on the page:

• The paper is too rough and a lot of dirt from paper falls to the inner components within the machine, so the transfer roller may be 
dirty. Clean the inside of your machine (see "Cleaning the machine" on page 55).

• The paper path may need cleaning. Clean the inside of your machine (see "Cleaning the machine" on page 55).

If these steps do not correct the problem, contact a service representative.

Condition Suggested Solutions
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Printing quality problems
Vertical lines If black vertical streaks appear on the page:

• The surface (drum part) of the imaging unit inside the machine has probably been scratched. Remove the toner cartridge and install 
a new one (see "Replacing the imaging unit" on page 53).

If white vertical streaks appear on the page:

• The surface of the LSU part inside the machine may be dirty. Clean the inside of your machine (see "Cleaning the machine" on page 
55). If these steps do not correct the problem, contact a service representative.

Black background If the amount of background shading becomes unacceptable:

• Change to a lighter weight paper.

• Check the environmental conditions: very dry conditions or a high level of humidity (higher than 80% RH) can increase the amount 
of background shading.

• Remove the old imaging unit and install a new one (see "Replacing the imaging unit" on page 53).

• Thoroughly redistribute the toner (see "Redistributing toner" on page 47).

Toner smear • Clean the inside of the machine (see "Replacing the toner cartridge" on page 49).

• Check the paper type and quality.

• Remove the old imaging unit and install a new one (see "Replacing the imaging unit" on page 53).

Condition Suggested Solutions
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Printing quality problems
Vertical repetitive defects If marks repeatedly appear on the printed side of the page at even intervals:

• The imaging unit may be damaged. If you still have the same problem, remove the imaging unit and, install a new one (see 
"Replacing the imaging unit" on page 53).

• Parts of the machine may have toner on them. If the defects occur on the back of the page, the problem will likely correct itself after 
a few more pages.

• The fusing assembly may be damaged. Contact a service representative.

Background scatter Background scatter results from bits of toner randomly distributed on the printed page. 

• The paper may be too damp. Try printing with a different batch of paper. Do not open packages of paper until necessary so that 
the paper does not absorb too much moisture.

• If background scatter covers the entire surface area of a printed page, adjust the print resolution through your software application 
or in Printing Preferences (see "Opening Printing Preferences" on page 36). Ensure the correct paper type is selected. For example: 
If Thicker Paper is selected, but Plain Paper actually used, an overcharging can occur causing this copy quality problem.

• If you are using a new toner cartridge, redistribute the toner first (see "Redistributing toner" on page 47). 

Toner particles are around bold 
characters or pictures

The toner might not adhere properly to this type of paper.

• Change the printer option and try again. Go to Printing Preferences, click the Paper tab, and set the paper type to Recycled (see 
"Opening Printing Preferences" on page 36).

• Ensure the correct paper type is selected. For example: If Thicker Paper is selected, but Plain Paper actually used, an overcharging 
can occur causing this copy quality problem.

Condition Suggested Solutions
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Printing quality problems
Misformed characters • If characters are improperly formed and producing hollow images, the paper stock may be too slick. Try different paper.

Page skew • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Ensure that the guides are not too tight or too loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.

• Check the paper type and quality. Both high temperature and humidity can cause paper curl.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Condition Suggested Solutions
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Printing quality problems
Wrinkles or creases • Ensure that the paper is loaded properly.

• Check the paper type and quality.

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray.

Back of printouts are dirty • Check for leaking toner. Clean the inside of the machine (see "Cleaning the machine" on page 55).

Solid color or black pages • The imaging unit may not be installed properly. Remove the imaging unit and reinsert it.

• The imaging unit may be defective. Remove the imaging unit and install a new one (see "Replacing the imaging unit" on page 53).

• The machine may require repairing. Contact a service representative.

Condition Suggested Solutions
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Printing quality problems
Loose toner • Clean the inside of the machine (see "Cleaning the machine" on page 55).

• Check the paper type and quality.

• Remove the imaging unit and then, install a new one (see "Replacing the imaging unit" on page 53).

If the problem persists, the machine may require repair. Contact a service representative.

Character voids Character voids are white areas within parts of characters that should be solid black:

• You may be printing on the wrong surface of the paper. Remove the paper and turn it around. 

• The paper may not meet paper specifications.

Horizontal stripes If horizontally aligned black streaks or smears appear:

• The imaging unit may be installed improperly. Remove the imaging unit and reinsert it.

• The imaging unit may be defective. Remove the imaging unit and install a new one (see "Replacing the imaging unit" on page 53).

If the problem persists, the machine may require repairing. Contact a service representative.

Condition Suggested Solutions
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Printing quality problems
 

Curl If the printed paper is curled or paper does not feed into the machine:

• Turn the stack of paper over in the tray. Also try rotating the paper 180° in the tray. 

• Change the printer’s paper option and try again. Go to Printing Preferences, click the Paper tab, and set type to Thin (see 
"Opening Printing Preferences" on page 36).

• An unknown image 
repetitively appears on a few 
sheets

• Loose toner

• Light print or contamination 
occurs

Your machine is probably being used at an altitude of 1,000 m (3,281 ft) or above.

The high altitude may affect the print quality, such as loose toner or light imaging. Change the altitude setting for your machine (See 
"Altitude adjustment" on page 132).

Condition Suggested Solutions
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Operating system problems

1 

Common Windows problems

 

Refer to the Microsoft Windows User’s Guide that came with your computer for further information on Windows error messages.

 

Condition Suggested solutions

“File in Use” message appears 
during installation.

Exit all software applications. Remove all software from the startup group, then restart Windows. Reinstall the printer driver.

“General Protection Fault”, 
“Exception OE”, “Spool 32”, or 
“Illegal Operation” messages 
appear.

Close all other applications, reboot Windows and try printing again.

“Fail To Print”, “A printer 
timeout error occurred” 
message appear.

These messages may appear during printing. Just keep waiting until the machine finishes printing. If the message appears in ready 
mode or after printing has completed, check the connection and/or whether an error has occurred.

Samsung Printer Experience is 
not shown when you click more 
settings.

Samsung Printer Experience is not installed. Download the app. from the Windows Store and install it.

Machine information is not 
displayed when you click the 
device in the Devices and 
Printers.

Check the Printer properties. Click the Ports tab.

(Control Panel > Devices and Printers > Right-click on your printer icon and select Printer properties)

If the port is set to File or LPT, uncheck them and select TCP/IP, USB, or WSD.
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Operating system problems

2 

Common Mac problems

 

 

 

Refer to the Mac User’s Guide that came with your computer for further information on Mac error messages.

 

Condition Suggested solutions

The machine does not print PDF files 
correctly. Some parts of graphics, text, or 
illustrations are missing.

Printing the PDF file as an image may enable the file to print. Turn on Print As Image from the Acrobat printing options. 

 

It will take longer to print when you print a PDF file as an image.

 

Some letters are not displayed normally 
during cover page printing.

Mac OS cannot create the font while printing the cover page. The English alphabet and numbers are displayed normally on 
the cover page.

When printing a document in Mac with 
Acrobat Reader 6.0 or higher, colors 
print incorrectly.

Make sure that the resolution setting in your machine driver matches the one in Acrobat Reader.
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Operating system problems

3 

Common Linux problems

 

 

 

Refer to the Linux User’s Guide that came with your computer for further information on Linux error messages.

 

Condition Suggested solutions

Unchecking the collate option 
in the Print Dialog does not 
work.

For some distributions, GNOME Print Dialog has an issue handling the collate option. As workaround, set the default value of collate 
option to False using the system's printing utility(execute "system-config-printer" in the Terminal program).

Printing always works with 
duplex.

This duplex issue was in Ubuntu 9.10 CUPS package. Update CUPS version to 1.4.1-5ubuntu2.2.

Printer is not added through 
system's printing utility.

The problem occurs on Debian 7 due to the defect in 'system-config-printer' package of the Debian 7 (http://bugs.debian.org/cgi-bin/
bugreport.cgi?bug=662813 in Debian bug tracking system). Please use another way to add printer (CUPS WebUI for example)

Paper size and orientation are 
disabled in the Print Dialog 
when opening text files.

The problem occurs on Fedora 19 and it's related to 'leafpad' text editor on Fedora 19. Please use other text editors like 'gedit'.

Printing produces divided 
images.

 This issue exists in openSUSE 13.2 due to wrong ghostscript provided by the system. Update 'cups-filters-ghostscript' package with the 
command "zypper install --force cups-filters-ghostscript" or with "Install/Remove Software" utility.
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Glossary

 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well as 
mentioned in this user’s guide.

 

802.11

802.11 is a set of standards for wireless local area network (WLAN) 

communication, developed by the IEEE LAN/MAN Standards Committee (IEEE 

802). 

802.11b/g/n

802.11b/g/n can share same hardware and use the 2.4 GHz band. 802.11b 

supports bandwidth up to 11 Mbps, 802.11n supports bandwidth up to 150 

Mbps. 802.11b/g/n devices may occasionally suffer interference from 

microwave ovens, cordless telephones, and Bluetooth devices.

Access point

Access Point or Wireless Access Point (AP or WAP) is a device that connects 

wireless communication devices together on wireless local area networks 

(WLAN), and acts as a central transmitter and receiver of WLAN radio signals. 

ADF

An Automatic Document Feeder (ADF) is a scanning unit that will automatically 

feed an original sheet of paper so that the machine can scan some amount of the 

paper at once. 

AppleTalk

AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 

computer networking. It was included in the original Mac (1984) and is now 

deprecated by Apple in favor of TCP/IP networking.

BIT Depth

A computer graphics term describing the number of bits used to represent the 

color of a single pixel in a bitmapped image. Higher color depth gives a broader 

range of distinct colors. As the number of bits increases, the number of possible 

colors becomes impractically large for a color map. 1-bit color is commonly 

called as monochrome or black and white.

BMP

A bitmapped graphics format used internally by the Microsoft Windows 

graphics subsystem (GDI), and used commonly as a simple graphics file format 

on that platform.
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BOOTP

Bootstrap Protocol. A network protocol used by a network client to obtain its IP 

address automatically. This is usually done in the bootstrap process of 

computers or operating systems running on them. The BOOTP servers assign 

the IP address from a pool of addresses to each client. BOOTP enables 'diskless 

workstation' computers to obtain an IP address prior to loading any advanced 

operating system.

CCD

Charge Coupled Device (CCD) is a hardware which enables the scan job. CCD 

Locking mechanism is also used to hold the CCD module to prevent any damage 

when you move the machine.

Collation

Collation is a process of printing a multiple-copy job in sets. When collation is 

selected, the device prints an entire set before printing additional copies.

Control Panel

A control panel is a flat, typically vertical, area where control or monitoring 

instruments are displayed. They are typically found in front of the machine. 

Coverage

It is the printing term used for a toner usage measurement on printing. For 

example, 5% coverage means that an A4 sided paper has about 5% image or text 

on it. So, if the paper or original has complicated images or lots of text on it, the 

coverage will be higher and at the same time, a toner usage will be as much as 

the coverage.

CSV

Comma Separated Values (CSV). A type of file format, CSV is used to exchange 

data between disparate applications. The file format, as it is used in Microsoft 

Excel, has become a de facto standard throughout the industry, even among 

non-Microsoft platforms.

DADF

A Duplex Automatic Document Feeder (DADF) is a scanning unit that will 

automatically feed and turn over an original sheet of paper so that the machine 

can scan on both sides of the paper.

Default

The value or setting that is in effect when taking a printer out of its box state, 

reset, or initialized.
185 Glossary



Glossary

DHCP

A Dynamic Host Configuration Protocol (DHCP) is a client-server networking 

protocol. A DHCP server provides configuration parameters specific to the DHCP 

client host requesting, generally, information required by the client host to 

participate on an IP network. DHCP also provides a mechanism for allocation of 

IP addresses to client hosts.

DIMM

Dual Inline Memory Module (DIMM), a small circuit board that holds memory. 

DIMM stores all the data within the machine like printing data, received fax data.

DLNA

The Digital Living Network Alliance (DLNA) is a standard that allows devices on 

a home network to share information with each other across the network.

DNS

The Domain Name Server (DNS) is a system that stores information associated 

with domain names in a distributed database on networks, such as the Internet.

Dot Matrix Printer

A dot matrix printer refers to a type of computer printer with a print head that 

runs back and forth on the page and prints by impact, striking an ink-soaked 

cloth ribbon against the paper, much like a typewriter.

DPI

Dots Per Inch (DPI) is a measurement of resolution that is used for scanning and 

printing. Generally, higher DPI results in a higher resolution, more visible detail 

in the image, and a larger file size.

DRPD 

Distinctive Ring Pattern Detection. Distinctive Ring is a telephone company 

service which enables a user to use a single telephone line to answer several 

different telephone numbers.

Duplex

A mechanism that will automatically turn over a sheet of paper so that the 

machine can print (or scan) on both sides of the paper. A printer equipped with 

a Duplex Unit can print on both sides of paper during one print cycle.

Duty Cycle

Duty cycle is the page quantity which does not affect printer performance for a 

month. Generally the printer has the lifespan limitation such as pages per year. 

The lifespan means the average capacity of print-outs, usually within the 

warranty period. For example, if the duty cycle is 48,000 pages per month 

assuming 20 working days, a printer limits 2,400 pages a day.
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ECM

Error Correction Mode (ECM) is an optional transmission mode built into Class 1 

fax machines or fax modems. It automatically detects and corrects errors in the 

fax transmission process that are sometimes caused by telephone line noise.

Emulation

Emulation is a technique of one machine obtaining the same results as another.

An emulator duplicates the functions of one system with a different system, so 

that the second system behaves like the first system. Emulation focuses on exact 

reproduction of external behavior, which is in contrast to simulation, which 

concerns an abstract model of the system being simulated, often considering its 

internal state.

Ethernet

Ethernet is a frame-based computer networking technology for local area 

networks (LANs). It defines wiring and signaling for the physical layer, and frame 

formats and protocols for the media access control (MAC)/data link layer of the 

OSI model. Ethernet is mostly standardized as IEEE 802.3. It has become the most 

widespread LAN technology in use during the 1990s to the present.

EtherTalk

A suite of protocols developed by Apple Computer for computer networking. It 

was included in the original Mac (1984) and is now deprecated by Apple in favor 

of TCP/IP networking. 

FDI

Foreign Device Interface (FDI) is a card installed inside the machine to allow a 

third party device such as a coin operated device or a card reader. Those devices 

allow the pay-for-print service on your machine.

FTP

A File Transfer Protocol (FTP) is a commonly used protocol for exchanging files 

over any network that supports the TCP/IP protocol (such as the Internet or an 

intranet).

Fuser Unit 

The part of a laser printer that fuses the toner onto the print media. It consists of 

a heat roller and a pressure roller. After toner is transferred onto the paper, the 

fuser unit applies heat and pressure to ensure that the toner stays on the paper 

permanently, which is why paper is warm when it comes out of a laser printer.
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Gateway

A connection between computer networks, or between a computer network 

and a telephone line. It is very popular, as it is a computer or a network that 

allows access to another computer or network.

Grayscale

A shades of gray that represents light and dark portions of an image when color 

images are converted to grayscale; colors are represented by various shades of 

gray.

Halftone

An image type that simulates grayscale by varying the number of dots. Highly 

colored areas consist of a large number of dots, while lighter areas consist of a 

smaller number of dots.

HDD

Hard Disk Drive (HDD), commonly referred to as a hard drive or hard disk, is a 

non-volatile storage device which stores digitally-encoded data on rapidly 

rotating platters with magnetic surfaces.

IEEE

The Institute of Electrical and Electronics Engineers (IEEE) is an international 

non-profit, professional organization for the advancement of technology 

related to electricity.

IEEE 1284

The 1284 parallel port standard was developed by the Institute of Electrical and 

Electronics Engineers (IEEE). The term "1284-B" refers to a specific connector 

type on the end of the parallel cable that attaches to the peripheral (for example, 

a printer). 

Intranet

A private network that uses Internet Protocols, network connectivity, and 

possibly the public telecommunication system to securely share part of an 

organization's information or operations with its employees. Sometimes the 

term refers only to the most visible service, the internal website.

IP address

An Internet Protocol (IP) address is a unique number that devices use in order to 

identify and communicate with each other on a network utilizing the Internet 

Protocol standard.
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IPM

The Images Per Minute (IPM) is a way of measuring the speed of a printer. An IPM 

rate indicates the number of single-sided sheets a printer can complete within 

one minute.

IPP

The Internet Printing Protocol (IPP) defines a standard protocol for printing as 

well as managing print jobs, media size, resolution, and so forth. IPP can be used 

locally or over the Internet to hundreds of printers, and also supports access 

control, authentication, and encryption, making it a much more capable and 

secure printing solution than older ones.

IPX/SPX

IPX/SPX stands for Internet Packet Exchange/Sequenced Packet Exchange. It is a 

networking protocol used by the Novell NetWare operating systems. IPX and 

SPX both provide connection services similar to TCP/IP, with the IPX protocol 

having similarities to IP, and SPX having similarities to TCP. IPX/SPX was 

primarily designed for local area networks (LANs), and is a very efficient protocol 

for this purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO

The International Organization for Standardization (ISO) is an international 

standard-setting body composed of representatives from national standards 

bodies. It produces world-wide industrial and commercial standards.

ITU-T

The International Telecommunication Union is an international organization 

established to standardize and regulate international radio and 

telecommunications. Its main tasks include standardization, allocation of the 

radio spectrum, and organizing interconnection arrangements between 

different countries to allow international phone calls. A -T out of ITU-T indicates 

telecommunication.

ITU-T No. 1 chart

Standardized test chart published by ITU-T for document facsimile 

transmissions.

JBIG

Joint Bi-level Image Experts Group (JBIG) is an image compression standard with 

no loss of accuracy or quality, which was designed for compression of binary 

images, particularly for faxes, but can also be used on other images.

JPEG

Joint Photographic Experts Group (JPEG) is a most commonly used standard 

method of lossy compression for photographic images. It is the format used for 

storing and transmitting photographs on the World Wide Web.
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LDAP

The Lightweight Directory Access Protocol (LDAP) is a networking protocol for 

querying and modifying directory services running over TCP/IP.

LED

A Light-Emitting Diode (LED) is a semiconductor device that indicates the status 

of a machine.

MAC address

Media Access Control (MAC) address is a unique identifier associated with a 

network adapter. MAC address is a unique 48-bit identifier usually written as 12 

hexadecimal characters grouped in pairs (e. g., 00-00-0c-34-11-4e). This address 

is usually hard-coded into a Network Interface Card (NIC) by its manufacturer, 

and used as an aid for routers trying to locate machines on large networks.

MFP

Multi Function Peripheral (MFP) is an office machine that includes the following 

functionality in one physical body, so as to have a printer, a copier, a fax, a 

scanner and etc.

MH

Modified Huffman (MH) is a compression method for decreasing the amount of 

data that needs to be transmitted between the fax machines to transfer the 

image recommended by ITU-T T.4. MH is a codebook-based run-length 

encoding scheme optimized to efficiently compress white space. As most faxes 

consist mostly of white space, this minimizes the transmission time of most 

faxes. 

MMR

Modified Modified READ (MMR) is a compression method recommended by ITU-

T T.6.

Modem

A device that modulates a carrier signal to encode digital information, and also 

demodulates such a carrier signal to decode transmitted information.

MR

Modified Read (MR) is a compression method recommended by ITU-T T.4. MR 

encodes the first scanned line using MH. The next line is compared to the first, 

the differences determined, and then the differences are encoded and 

transmitted.
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NetWare

A network operating system developed by Novell, Inc. It initially used 

cooperative multitasking to run various services on a PC, and the network 

protocols were based on the archetypal Xerox XNS stack. Today NetWare 

supports TCP/IP as well as IPX/SPX.

OPC

Organic Photo Conductor (OPC) is a mechanism that makes a virtual image for 

print using a laser beam emitted from a laser printer, and it is usually green or 

rust colored and has a cylinder shape. 

An imaging unit containing a drum slowly wears the drum surface by its usage 

in the printer, and it should be replaced appropriately since it gets worn from 

contact with the cartridge development brush, cleaning mechanism, and paper.

Originals

The first example of something, such as a document, photograph or text, etc, 

which is copied, reproduced or translated to produce others, but which is not 

itself copied or derived from something else.

OSI

Open Systems Interconnection (OSI) is a model developed by the International 

Organization for Standardization (ISO) for communications. OSI offers a 

standard, modular approach to network design that divides the required set of 

complex functions into manageable, self-contained, functional layers. The layers 

are, from top to bottom, Application, Presentation, Session, Transport, Network, 

Data Link and Physical.

PABX 

A private automatic branch exchange (PABX) is an automatic telephone 

switching system within a private enterprise.

PCL

Printer Command Language (PCL) is a Page Description Language (PDL) 

developed by HP as a printer protocol and has become an industry standard. 

Originally developed for early inkjet printers, PCL has been released in varying 

levels for thermal, dot matrix printer, and laser printers.

PDF

Portable Document Format (PDF) is a proprietary file format developed by 

Adobe Systems for representing two dimensional documents in a device 

independent and resolution independent format.
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PostScript

PostScript (PS) is a page description language and programming language used 

primarily in the electronic and desktop publishing areas. - that is run in an 

interpreter to generate an image.

Printer Driver

A program used to send commands and transfer data from the computer to the 

printer.

Print Media

The media like paper, labels, and transparencies which can be used in a printer, 

a scanner, a fax or, a copier.

PPM

Pages Per Minute (PPM) is a method of measurement for determining how fast 

a printer works, meaning the number of pages a printer can produce in one 

minute.

PRN file

An interface for a device driver, this allows software to interact with the device 

driver using standard input/output system calls, which simplifies many tasks. 

Protocol

A convention or standard that controls or enables the connection, 

communication, and data transfer between two computing endpoints.

PS

See PostScript.

PSTN

The Public-Switched Telephone Network (PSTN) is the network of the world's 

public circuit-switched telephone networks which, on industrial premises, is 

usually routed through the switchboard.

RADIUS

Remote Authentication Dial In User Service (RADIUS) is a protocol for remote 

user authentication and accounting. RADIUS enables centralized management 

of authentication data such as usernames and passwords using an AAA 

(authentication, authorization, and accounting) concept to manage network 

access.

Resolution

The sharpness of an image, measured in Dots Per Inch (DPI). The higher the dpi, 

the greater the resolution.
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SMB

Server Message Block (SMB) is a network protocol mainly applied to share files, 

printers, serial ports, and miscellaneous communications between nodes on a 

network. It also provides an authenticated Inter-process communication 

mechanism.

SMTP

Simple Mail Transfer Protocol (SMTP) is the standard for e-mail transmissions 

across the Internet. SMTP is a relatively simple, text-based protocol, where one 

or more recipients of a message are specified, and then the message text is 

transferred. It is a client-server protocol, where the client transmits an email 

message to the server.

SSID

Service Set Identifier (SSID) is a name of a wireless local area network (WLAN). All 

wireless devices in a WLAN use the same SSID in order to communicate with 

each other. The SSIDs are case-sensitive and have a maximum length of 32 

characters.

Subnet Mask 

The subnet mask is used in conjunction with the network address to determine 

which part of the address is the network address and which part is the host 

address.

TCP/IP

The Transmission Control Protocol (TCP) and the Internet Protocol (IP); the set of 

communications protocols that implement the protocol stack on which the 

Internet and most commercial networks run.

TCR

Transmission Confirmation Report (TCR) provides details of each transmission 

such as job status, transmission result and number of pages sent. This report can 

be set to print after each job or only after failed transmissions.

TIFF

Tagged Image File Format (TIFF) is a variable-resolution bitmapped image 

format. TIFF describes image data that typically come from scanners. TIFF 

images make use of tags, keywords defining the characteristics of the image that 

is included in the file. This flexible and platform-independent format can be 

used for pictures that have been made by various image processing 

applications.

Toner Cartridge

A kind of bottle or container used in a machine like a printer which contains 

toner. Toner is a powder used in laser printers and photocopiers, which forms 

the text and images on the printed paper. Toner can be fused by a combination 

of heat/pressure from the fuser, causing it to bind to the fibers in the paper.
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TWAIN

An industry standard for scanners and software. By using a TWAIN-compliant 

scanner with a TWAIN-compliant program, a scan can be initiated from within 

the program. It is an image capture API for Microsoft Windows and Apple Mac 

operating systems.

UNC Path

Uniform Naming Convention (UNC) is a standard way to access network shares 

in Window NT and other Microsoft products. The format of a UNC path is: 

\\<servername>\<sharename>\<Additional directory>

URL

Uniform Resource Locator (URL) is the global address of documents and 

resources on the Internet. The first part of the address indicates what protocol to 

use, the second part specifies the IP address or the domain name where the 

resource is located.

USB

Universal Serial Bus (USB) is a standard that was developed by the USB 

Implementers Forum, Inc., to connect computers and peripherals. Unlike the 

parallel port, USB is designed to concurrently connect a single computer USB 

port to multiple peripherals.

Watermark

A watermark is a recognizable image or pattern in paper that appears lighter 

when viewed by transmitted light. Watermarks were first introduced in Bologna, 

Italy in 1282; they have been used by papermakers to identify their product, and 

also on postage stamps, currency, and other government documents to 

discourage counterfeiting.

WEP

Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 802.11 to 

provide the same level of security as that of a wired LAN. WEP provides security 

by encrypting data over radio so that it is protected as it is transmitted from one 

end point to another.

WIA

Windows Imaging Architecture (WIA) is an imaging architecture that is originally 

introduced in Windows Me and Windows XP. A scan can be initiated from within 

these operating systems by using a WIA-compliant scanner.

WPA

Wi-Fi Protected Access (WPA) is a class of systems to secure wireless (Wi-Fi) 

computer networks, which was created to improve upon the security features of 

WEP.
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WPA-PSK

WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small business or 

home users. A shared key, or password, is configured in the wireless access point 

(WAP) and any wireless laptop or desktop devices. WPA-PSK generates a unique 

key for each session between a wireless client and the associated WAP for more 

advanced security.

WPS

The Wi-Fi Protected Setup (WPS) is a standard for establishing a wireless home 

network. If your wireless access point supports WPS, you can configure the 

wireless network connection easily without a computer.

XPS

XML Paper Specification (XPS) is a specification for a Page Description Language 

(PDL) and a new document format, which has benefits for portable document 

and electronic document, developed by Microsoft. It is an XML-based 

specification, based on a new print path and a vector-based device-

independent document format.
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